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Important Information
SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED OR 
BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED 
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SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR ANY 
OTHER PURPOSE.
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WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS 
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR 
CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF 
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ANY SOFTWARE ITEM IDENTIFIED AS THIRD PARTY LIBRARY IS AVAILABLE UNDER SEPARATE 
SOFTWARE LICENSE TERMS AND IS NOT PART OF A TIBCO PRODUCT. AS SUCH, THESE SOFTWARE ITEMS 
ARE NOT COVERED BY THE TERMS OF YOUR AGREEMENT WITH TIBCO, INCLUDING ANY TERMS 
CONCERNING SUPPORT, MAINTENANCE, WARRANTIES, AND INDEMNITIES. DOWNLOAD AND USE OF 
THESE ITEMS IS SOLELY AT YOUR OWN DISCRETION AND SUBJECT TO THE LICENSE TERMS 
APPLICABLE TO THEM. BY PROCEEDING TO DOWNLOAD, INSTALL OR USE ANY OF THESE ITEMS, YOU 
ACKNOWLEDGE THE FOREGOING DISTINCTIONS BETWEEN THESE ITEMS AND TIBCO PRODUCTS.

This document is subject to U.S. and international copyright laws and treaties. No part of this document may be reproduced 
in any form without the written authorization of TIBCO Software Inc.
TIBCO, the TIBCO logo, the TIBCO O logo, TIB, Information Bus, TIBCO Administrator, TIBCO ActiveMatrix 
BusinessWorks, TIBCO Business Studio, TIBCO Designer, TIBCO Enterprise Message Service, TIBCO Runtime Agent, 
and TIBCO Rendezvous are either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or 
other countries.
Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle Corporation and/or its 
affiliates.
All other product and company names and marks mentioned in this document are the property of their respective owners and 
are mentioned for identification purposes only.
This software may be available on multiple operating systems. However, not all operating system platforms for a specific 
software version are released at the same time. See the readme file for the availability of this software version on a specific 
operating system platform.
THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.
THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES 
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED 
IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR 
CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.
THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR 
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT 
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.
This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to TIBCO's Virtual 
Patent Marking document (https://www.tibco.com/patents) for details.
Copyright © 1994-2019. TIBCO Software Inc. All Rights Reserved. 
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Preface

TIBCO BusinessConnect™ Services Plug-in is an easy-to-use data transfer protocol, 
which provides a secure data exchange over the Internet.

Topics

• Related Documentation, page xii

• Typographical Conventions, page xiv

• TIBCO Product Documentation and Support Services, page xvi
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Related Documentation

This section lists documentation resources you may find useful.

TIBCO BusinessConnect™ Services Plug-in Documentation
The following documents form the TIBCO BusinessConnect Services Plug-in 
documentation set:

• TIBCO BusinessConnect™ Services Plug-in Installation and Configuration: Read 
this guide to install and configure TIBCO BusinessConnect Services Plug-in.

• TIBCO BusinessConnect™ Services Plug-in User’s Guide: Read this guide to learn 
how to manage TIBCO BusinessConnect Services Plug-in. 

• TIBCO BusinessConnect™ Services Plug-in Release Notes: Read the release notes for 
a list of new and changed features. This document also contains lists of known issues 
and closed issues for this release.

Other TIBCO Product Documentation
You may find it useful to read the documentation for the following TIBCO products, 
which may be used or integrated with BusinessConnect:

• TIBCO Administrator™ software: The software allows you to manage users, 
machines and applications defined in a TIBCO Administration Domain. The TIBCO 
Administrator graphical user interface enables users to deploy, monitor, and start and 
stop TIBCO applications.

• TIBCO ActiveMatrix BusinessWorks™ software: This software is a scalable, 
extensible, and easy to use integration platform that allows you to develop integration 
projects. TIBCO BusinessWorks includes a graphical user interface (GUI) for 
defining business processes and an engine that executes the process.

• TIBCO Business Studio™ software: This graphical user interface is used for 
designing and creating integration project configurations and building an Enterprise 
Archive (EAR) for the project. The EAR can then be used by TIBCO Enterprise 
Administrator for deploying and running the application.

• TIBCO Designer™ software: This graphical user interface is used for designing and 
creating integration project configurations and building an Enterprise Archive (EAR) 
for the project. The EAR can then be used by TIBCO Administrator for deploying and 
running the application.
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• TIBCO Enterprise Message Service ™ software: This software provides a message 
service that enables integration of applications within an enterprise based on the Java 
Message Service (JMS) specifications.

• TIBCO Hawk® software: This software is a tool for monitoring and managing 
distributed applications and operating systems. The software is designed specifically 
for monitoring distributed systems, so there is no centralized console or frequent 
polling across the network.

• TIBCO Runtime Agent™ software: This software suite is a prerequisite for other 
TIBCO software products. In addition to TIBCO Runtime Agent components, the 
software suite includes the third-party libraries used by other TIBCO products such as 
TIBCO Designer, Java Runtime Environment (JRE), TIBCO Hawk®, and TIBCO 
Rendezvous®.

• TIBCO Rendezvous® software: This software enables programs running on many 
different kinds of computers on a network to communicate seamlessly. It includes two 
main components: the Rendezvous programming language interface (API) in several 
languages, and the Rendezvous daemon.
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Typographical Conventions

The following typographical conventions are used in this manual.

Table 1   General Typographical Conventions 

Convention Use

ENV_NAME

TIBCO_HOME 
EZCOMM_HOME 

TIBCO products are installed into an installation environment. A product installed into 
an installation environment does not access components in other installation 
environments. Incompatible products and multiple instances of the same product must be 
installed into different installation environments.

An installation environment consists of the following properties:

• Name  Identifies the installation environment. This name is referenced in 
documentation as ENV_NAME. On Microsoft Windows, the name is appended to the 
name of Windows services created by the installer and is a component of the path to 
the product shortcut in the Windows Start > All Programs menu. 

• Path  The folder into which the product is installed. This folder is referenced in 
documentation as TIBCO_HOME. 

TIBCO BusinessConnect Services Plug-in installs into a directory within a 
TIBCO_HOME. This directory is referenced in documentation as EZCOMM_HOME. The 
default value of EZCOMM_HOME depends on the operating system. For example on 
Windows systems, the default value is 

C:\tibco\bc\version\protocols\ezcomm.

code font Code font identifies commands, code examples, filenames, pathnames, and output 
displayed in a command window. For example:

Use MyCommand to start the foo process.

bold code font Bold code font is used in the following ways:

• In procedures, to indicate what a user types. For example: Type admin. 

• In large code samples, to indicate the parts of the sample that are of particular 
interest.

• In command syntax, to indicate the default parameter for a command. For example, 
if no parameter is specified, MyCommand is enabled: 
MyCommand [enable | disable]
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italic font Italic font is used in the following ways: 

• To indicate a document title. For example: See TIBCO ActiveMatrix BusinessWorks 
Concepts.

• To introduce new terms For example: A portal page may contain several portlets. 
Portlets are mini-applications that run in a portal.

• To indicate a variable in a command or code syntax that you must replace. For 
example: MyCommand PathName

Key combinations Key name separated by a plus sign indicate keys pressed simultaneously. For example: 
Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the other. 
For example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for example, 
an additional action required only in certain circumstances.

The tip icon indicates an idea that could be useful, for example, a way to apply the 
information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, data loss 
or corruption if certain steps are taken or not taken.

Table 1   General Typographical Conventions (Cont’d)

Convention Use
 TIBCO BusinessConnect Services Plug-in User’s Guide
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TIBCO Product Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO 
Support, or join TIBCO Community.

How to Access TIBCO Documentation
Documentation for TIBCO products is available on the TIBCO Product Documentation 
website mainly in the HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current 
than any other documentation included with the product. To access the latest 
documentation, visit https://docs.tibco.com. 

Documentation for TIBCO BusinessConnect Services Plug-in is available on the 
https://docs.tibco.com/products/tibco-businessconnect-services-plug-in Product 
Documentation page.

How to Contact TIBCO Support
You can contact TIBCO Support in the following ways:

• For an overview of TIBCO Support, and information about getting started with 
TIBCO Support, visit http://www.tibco.com/services/support

• For accessing the Support Knowledge Base and getting personalized content about 
products you are interested in, visit the TIBCO Support portal at 
https://support.tibco.com.

• For creating a Support case, you must have a valid maintenance or support contract 
with TIBCO. You also need a user name and password to log in to 
https://support.tibco.com. If you do not have a user name, you can request one by 
clicking Register on the website.

How to Join TIBCO Community
TIBCO Community is the official channel for TIBCO customers, partners, and employee 
subject matter experts to share and access their collective experience. TIBCO Community 
offers access to Q&A forums, product wikis, and best practices. It also offers access to 
extensions, adapters, solution accelerators, and tools that extend and enable customers to 
gain full value from TIBCO products. In addition, users can submit and vote on feature 
requests from within the TIBCO Ideas Portal. For a free registration, go to 
https://community.tibco.com.
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Chapter 1 Introduction

This chapter introduces TIBCO BusinessConnect™ Services Plug-in and its features.

Topics

• Overview, page 2

• Protocol Features, page 3
 TIBCO BusinessConnect Services Plug-in User’s Guide
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Overview

TIBCO BusinessConnect Services Plug-in (later in this document referred to as Services 
Plug-in) is an easy-to-use data transfer protocol, which allows you to securely exchange 
data over the Internet. 

Trading partners managed by BusinessConnect can quickly and efficiently be configured 
to exchange documents securely with the BusinessConnect host over the Internet using 
this plug-in, without understanding or interpreting the document contents.

With the introduction to the Request/Response operation type, the Services Plug-in allows 
tracking of each document sent to or received from a trading partner, independent of the 
transport mechanism, and correlates the corresponding response document with the 
trading partner. The back office applications focus on the processing of the document 
contents sent to or received from BusinessConnect, which ensures that the response 
document is properly logged with the corresponding request document and delivered or 
received to or from the trading partner on time. 
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Protocol Features

The Services Plug-in has the following features:

Support for Public Transports 

The basic transport connectivity includes the File, Email, HTTP/S, FTP/S, and SSHFTP 
transports. These transports follow industry transport protocol standards such as AS1, 
AS2, SMTP, POP, S/MIME, SSH, SSL to provide document security by encryption and 
document authenticity by digital signature.

To learn more about public transports and their configuration, see TIBCO 
BusinessConnect Concepts, Chapter 5, TIBCO BusinessConnect Transports and 
Protocols.

Support for Private Transports

The Services Plug-in supports the following private transports: TIBCO Rendezvous and 
JMS.

These private transports are explained in TIBCO BusinessConnect Concepts, Private 
Processes.

Support for Operations 

The following operations are supported in the Services Plug-in:

• Notify Operation, page 35

Notify operation is a one way operation. It can send a document to the trading partner 
and receive the acknowledgement. It is not capable of receiving the response from the 
trading partner. 

• Synchronous Request Response Operation, page 36

Synchronous Request Response operation sends the document to the trading partner 
and waits for the response until the response is received; it suspends any further 
processing for that request.

• Asynchronous Request Response Operation, page 37

Asynchronous Request Response operation sends the document to the trading partner 
and waits for the response, but it allows further processing irrespective of the response 
arrival from the partner.
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XML Validation

The Services Plug-in supports XSD and DTD schema validation. To learn more about 
validating schemas, see Configuring Services Plug-in Operations, page 39.

Support for Multiple Attachments

The Services Plug-in allows multiple attachments. Private process can send these 
attachments in a sequence and each Attachment has the following structure.

For more information, see Multiple Attachments, page 83.

Duplicate Message Detection

The Services Plug-in allows both incoming and outgoing public messages to be verified 
for duplicates. 

For more details, see Duplicate Message Detection, page 33.

Other Supported Features

• Electronic signing and message encryption or decryption. 

To learn more about security in BusinessConnect, see TIBCO BusinessConnect 
Concepts, Chapter 8, Security.

• Audit logging, including the user transactionID in the audit log.

To learn more about audit logging in TIBCO BusinessConnect Services Plug-in, see 
Audit Logs, page 86.

• Exchange of notices with trading partners.

• XML, plain text, and binary data blobs.
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Chapter 2 Tutorial 

This chapter presents a complete tutorial on installing and configuring the Services 
Plug-in for the Asynchronous Request Response operation.

Topics

• Overview, page 6

• Prerequisites, page 7

• Tutorial Steps, page 8
 TIBCO BusinessConnect Services Plug-in User’s Guide
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Overview

This tutorial gives an example of an Asynchronous Request Response operation:

• How to create private processes on the Initiator and the Responder side.

• How to create and process an Asynchronous Request Response operation. 

In this tutorial, the following two computers are required:

• The Initiator computer Buyer

• The Responder computer Seller

For an overview of the operation, see Asynchronous Request Response Operation, 
page 37.
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Prerequisites

Before starting this tutorial:

1. Install the following software packages:

a. TIBCO BusinessConnect, as described in TIBCO BusinessConnect Installation 
and Configuration.

b. TIBCO BusinessConnect Services Plug-in, as described in TIBCO 
BusinessConnect Services Plug-in Installation and Configuration.

2. Perform all pre-deployment and deployment configuration procedures described in 
TIBCO BusinessConnect Interior Server Administration Guide, Chapter 2, Interior 
Server Quick Start. 

Import the pre-configured operations to use in the tutorial, as explained in Importing the 
Tutorial, page 8.

These prerequisites are performed on both the Initiator and the Responder computers.
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Tutorial Steps

This tutorial requires that you follow the following steps:

1. Importing the Tutorial, page 8

This step is performed on both the Initiator and the Responder computers.

2. Configuring the Initiator TIBCO BusinessConnect, page 9

This step is performed only on the Initiator computer.

3. Configuring the Responder TIBCO BusinessConnect, page 13

This step is performed only on the Responder computer.

4. Configuring Private Processes, page 17

This step is performed on both the Initiator and the Responder computers.

5. Running the Tutorial, page 22

This step is performed on both the Initiator and the Responder computers.

Importing the Tutorial
Before you can configure trading partners for the Services Plug-in transactions, you must 
first configure an operation as explained in Configuring Services Plug-in Operations, 
page 39. This tutorial uses pre-configured operations, which are imported together with 
the tutorial.

To import the tutorial on both computers (Initiator and Responder):

1. In TIBCO Administrator, click BusinessConnect > Operations Editor.

2. Click Import.

3. Click the change link and upload the following file:

— For TIBCO Designer:

BC_HOME\protocols\ezcomm\samples\interfaces\ezcommtutorial-operations.csx

— For TIBCO Business Studio:

BC_HOME\protocols\ezcomm\samples\interfaces\ezcommtutorial_for_bw6-operations.csx

4. Enter a password if it is necessary.

5. Click Import.

It imports two operations named Manage Widgets and Widget Inventory. The default Notify 
operation and the two imported operations are displayed on the Edit Operations page:
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Figure 1   Imported Operations Manage Widgets and Widget Inventory

6. Click Done.

Once the operations are imported, continue with configuring the computers. 

Configuring the Initiator TIBCO BusinessConnect
In this tutorial, the hosts computer’s name is Buyer, and the partner’s computer name is 
Seller.

Follow the steps as described in these sections:

• Configuring the Initiator Default Host, page 9

• Configuring the Initiator Partner, page 10

• Configuring the Initiator Business Agreement, page 11

Configuring the Initiator Default Host

1. Click BusinessConnect > Participants.

2. Click New.

3. Type Buyer in the Name field.

See Configuring Services Plug-in for a Host for more information about setting up a host 
in a business agreement.
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4. Select Host from the Type list.

5. Click OK.

6. On the New Host Participant page, select the Active check box. 

7. Click Apply.

8. Click BusinessConnect > System Settings on the left panel.

9. Click General. 

10. Verify Buyer is selected from the Default Host list.

11. Click Save.

Configuring the Initiator Partner

1. Click BusinessConnect > Participants.

2. Click New.

3. Type Seller in the Name field.

4. Select Partner in the Type list.

5. Click OK.

6. On the New Partner Participant page, select the Active check box. 

7. Click Apply.

Enable Protocol
for the Initiator

Partner

8. On the Edit Partner Participant page, select the Protocols tab.

9. Click Enable. 

10. Select the EZComm check box.

11. Click OK.

The EZComm protocol is now in the Protocol Name field.

Add Transport for
the Initiator

Partner
1. Click EZComm in the Protocol Name field.

2. Select the Transports tab.

For this tutorial, you do not need to do the further edit of the protocols configuration.

See Configuring Services Plug-in for a Partner for more information about setting up a 
partner in a business agreement.
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3. Click Add. 

4. On the New Transport page, enter data as explained in Table 2.

5. Click OK.

Define URL 6. On the New HTTP Transport page, enter information as shown in Table 3.

7. Click Save three times.

Configuring the Initiator Business Agreement

After both trading partners are configured, configure the business agreement.

1. Click BusinessConnect > Business Agreements.

2. Click New. 

Table 2   New Transport for the Partner

Field Description

Name Enter the name for the transport (required).

Type Select the transport type from the Type list. For this tutorial, select HTTP.

Table 3   New HTTP Transport

Field Description

Transport Name Enter a name for this transport (required).

URL URL of the company (required): www.hostname:6700/dmz/EZComm.

Use HTTP Basic Authentication Clear the check box Use HTTP Basic Authentication.

Username No entry required for this tutorial.

Password No entry required for this tutorial.

Retry Count Leave the default (3). 

Retry Interval Leave the default (60).

Socket Timeout (seconds) Leave the default (300).

This section contains only the steps necessary for this tutorial, see Adding a New Business 
Agreement for a complete explanation.
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Verify that the plug-in is displayed in the Protocols column for both trading partners. 
If it is missing, return to Enable Protocol for the Initiator Partner and enable it.

3. Click Buyer in the Host Party area.

4. Click Seller in the Partner Party area.

5. Click OK. 

6. Confirm that the Valid check box in the General tab is selected. This makes the 
agreement valid immediately.

The following steps shows how to add operation bindings for the Initiator Business 
Agreement

To add a protocol binding for this business agreement:

1. Click Add Protocol Bindings on the New Agreement page.

2. Select the EZComm check box.

3. Click OK.

The Plug-in now is displayed in the Agreement Protocol Binding list.

4. Click EZComm. 

The Edit Protocol Binding page is displayed with the Operation Bindings tab 
selected by default. 

Operation
Bindings Tab

5. Enter information according to Table 4.

Add Binding for
the Host

6. On the Host can initiate panel, click Add Operation Binding.

For this tutorial, select the Manage Widgets/1.0/buyWidgets check box.

7. Click OK.

The selected operation is displayed in the Operation Name list.

This section contains only the steps necessary for this tutorial, see Configuring Agreement 
Protocol Binding for Services Plug-in for a complete explanation.

Table 4   Edit Protocol Binding: Operation Binding Tab

Field Description

Allow All Operations For this tutorial, clear the Allow All Operations check box.

Non-Repudiation 
Logging

For this tutorial, select the Non-Repudiation Logging check box.
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To configure the Host can Initiate: Override Outbound Settings section:

1. Click Manage Widgets/1.0/buyWidgets in the Host can initiate section.

2. Click the Transports tab.

Transports Tab 3. Configure transport settings as shown in Table 5.

4. Click Save.

This creates an operation binding for the buyWidget operation that overrides any 
outgoing request for this operation.

The same binding is used for the incoming response for this request; for example, if 
you want to override the schema validation for an incoming response, you can select 
the desired value in the Operation Settings tab for this binding.

Configuring the Responder TIBCO BusinessConnect
This section describes how to configure the Responder TIBCO BusinessConnect on 
another computer, where your previous host becomes a partner, and the previous partner is 
now the host. If the second computer does not contain a deployed version of TIBCO 
BusinessConnect, proceed as follows:

1. Repeat all pre-deployment and deployment steps for the second computer, as 
described in Prerequisites, page 7 and Importing the Tutorial, page 8.

2. Start TIBCO Administrator and click the TIBCO BusinessConnect link.

3. Follow the steps as described in these sections:

— Configuring the Responder Default Host, page 14

— Configuring the Responder Partner, page 14

— Configuring the Responder Business Agreement, page 15

Table 5   Override Outbound Settings: Transports Tab 

Field Description

Override Transports For this tutorial, select the Override Transports check box.

Override Outbound Transports

Primary Transport For this tutorial, select HTTP.
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Configuring the Responder Default Host

1. Click BusinessConnect > Participants.

2. Click New.

3. Type Seller in the Name field.

4. Select Host from the Type list.

5. Click OK.

6. On the New Host Participant page, select the Active check box. 

7. Click Apply.

8. Click BusinessConnect > System Settings on the left panel.

9. Click General. 

10. Verify that Seller is selected from the Default Host list.

11. Click Save.

Configuring the Responder Partner

1. Click BusinessConnect > Participants.

2. Click New.

3. Type Buyer in the Name field.

4. Select Partner from the Type list.

5. Click OK.

6. On the New Partner Participant page, select the Active check box. 

7. Click Apply.

See Configuring Services Plug-in for a Host for more information about setting up a host 
in a business agreement.

For this tutorial, there is no need to further edit protocol configuration.

See Configuring Services Plug-in for a Partner for more information about setting up a 
partner in a business agreement.
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Enable Protocol
for the Responder

Partner

8. On the Edit Partner Participant page, click the Protocols tab.

9. Click Enable. 

10. Select the EZComm check box.

11. Click OK.

The EZComm protocol is now in the Protocol Name list.

Add Transport for
the Responder

Partner
1. Click the EZComm link.

2. Click the Transports tab.

3. Click Add. 

4. On the New Transport page, enter data as explained in Table 6.

5. Click OK. The New HTTP Transport page is displayed.

Define URL 6. Enter the data related to this new transport, as explained in Table 3:

www.hostname.com:6700/dmz/EZComm. 

7. Click Save three times.

Configuring the Responder Business Agreement

1. Click BusinessConnect > Business Agreements.

2. Click New. 

3. Select Seller in the Host Party panel.

4. Select Buyer in the Partner Party panel.

For this tutorial, there is no need to further edit protocol configuration.

Table 6   New Transport for the Partner

Field Description

Name Enter the name for the transport (required)

Type Select the transport type from the dropdown list. For this tutorial, select HTTP.

This section only contains the steps that are necessary for this tutorial. See Adding a New 
Business Agreement for a complete explanation regarding this topic.
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5. Click OK. 

6. Confirm that the Valid check box is selected. It makes the agreement valid 
immediately.

7. Click Add Protocol Bindings.

8. Select the EZComm check box.

9. Click OK.

EZComm now is displayed in the Agreement Protocol Binding list.

10. Click Save.

To add operation bindings for the Responder Business Agreement:

1. Click the Business Agreement link.

2. On the Edit Agreement page, click the EZComm link. 

The Edit Protocol Binding page is displayed with the Operation Bindings tab 
selected by default. 

Operation
Bindings Tab

3. Enter information according to Table 7.

Add Binding for
the Partner

4. In the Responding Operations section, click Add Operation Binding.

For this tutorial, select Manage Widgets/1.0/buyWidgets.

5. Click OK.

The selected operation is displayed in the Operation Name list.

To configure the Partner can Initiate: Override Inbound Settings section:

1. Click Manage Widgets/1.0/buyWidgets in the Responding Operations panel.

This section only contains the steps that are necessary for this tutorial. See Configuring 
Agreement Protocol Binding for Services Plug-in, page 59 for a complete explanation 
regarding this topic.

Table 7   Edit Protocol Binding: Operation Binding Tab

Field Description

Allow All Operations Clear the check box for this tutorial.

Non-Repudiation 
Logging

Select the check box for this tutorial.
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2. Click the Transports tab.

Transports Tab 3. Configure transport settings as shown in Table 8.

4. Click Save.

This creates an operation binding for the buyWidget operation that overrides any 
incoming request for this operation. 

The same binding is used for the outgoing response for this request; for example, if 
you want to override the schema validation for an outgoing response, you can select 
the desired value in the Operation Settings tab for this binding.

Configuring Private Processes
This section describes how to configure the private processes on the Initiator and 
Responder computers in the following ways: 

• Configuring Private Processes in TIBCO Designer, page 17

• Configuring Private Processes in TIBCO Business Studio, page 21

Configuring Private Processes in TIBCO Designer

To configure private processes in TIBCO Designer:

• Task A, Open the BusinessWorks Project

• Task B, Configure Connections to Initiator TIBCO BusinessConnect

• Task C, Configure Connections to Responder TIBCO BusinessConnect

Table 8   Override Inbound Settings: Transports Tab 

Field Description

Override Transports Check the check box for this tutorial.

Override Outbound Transports

Primary Transport For this tutorial, select HTTP.

To configure private processes, installing TIBCO BusinessConnect Palette in TIBCO 
Designer or TIBCO ActiveMatrix BusinessWorks Plug-in for BusinessConnect in TIBCO 
Business Studio are required.

To install TIBCO BusinessConnect Palette or TIBCO ActiveMatrix BusinessWorks 
Plug-in in BusinessConnect, see TIBCO BusinessConnect Palette Installation or TIBCO 
ActiveMatrix BusinessWorks Plug-in for BusinessConnect Installation for more details.
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Task A Open the BusinessWorks Project

To open the TIBCO ActiveMatrix BusinessWorks project in TIBCO Designer:

1. Start TIBCO Designer.

2. Click New empty project.

3. On the Save Project page, click Cancel.

4. Click Project > Import Full Project.

5. Click Select a file from the file system  next to the File field of the ZIP Archive 
tab to navigate to the ezcomm.zip file. 

The sample is located in the BC_HOME/protocols/ezcomm/samples/tutorial directory.

6. Click Open and then click OK. 

7. In the Options tab, click Try rename in case of name conflict. 

8. Click Apply.

9. Click Project > Save As.

10. Click Select a file from the file system  next to the Project Directory field to 
navigate to a folder where you want to save the sample project.

11. Select ISO8859-1 from the TIBCO Messaging Encoding list.

Select None from the Multi-User System list.

12. Click OK.

If you want to restore the project for later use, you must select a directory other than the 
BC_HOME/protocols/ezcomm/samples/tutorial directory. 

If your select the same directory, the .zip file is deleted.
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Figure 2   TIBCO Designer: BusinessWorks Project

Task B Configure Connections to Initiator TIBCO BusinessConnect

To configure connections to TIBCO BusinessConnect on the Initiator computer:

1. In the expanded project tree, double-click the Initiator  connection icon.

2. Click the BusinessConnect Server Access tab.

3. Enter information as explained in Table 9.

Table 9   BusinessConnect Server Access Tab

Field Description

JDBC Driver Type Select the JDBC driver that you use to communicate with the BusinessConnect 
configuration store from the JDBC Driver Type list.

JDBC Driver Select the JDBC driver to use with the database.

JDBC URL Type the URL for the configuration store.

DB User Provide a valid user name for the database.
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4. Click Apply.

5. Click Update from Configuration Store in the Configuration tab.

6. Select EZComm from the Protocol Name list.

If you select the Select Operations check box, you could select any of the 
configured/imported operations. For this tutorial, select all operations and click OK.

7. Click Import Selected Business Protocol. 

The INIATOR (BusinessConnect Connection) screen is displayed.

Figure 3   INITIATOR (BusinessConnect Connection) 

In the Imported Operations field, you could see the operations that you have 
imported in Importing the Tutorial, page 8.

When you import the protocol, BusinessWorks retrieves information from the TIBCO 
BusinessConnect configuration store and puts it in the project folder. 

8. Click Apply.

9. Click Save.

DB Password The password associated with the database user name.

Table 9   BusinessConnect Server Access Tab

Field Description
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Task C Configure Connections to Responder TIBCO BusinessConnect

On the Responder computer, complete all steps explained in Task B, Configure 
Connections to Initiator TIBCO BusinessConnect, page 19, replacing all instances of 
Initiator with Responder.

Configuring Private Processes in TIBCO Business Studio

To configure the private process in TIBCO Business Studio:

• Task A, Open the BusinessWorks Project

• Task B, Configure Connections to Initiator TIBCO BusinessConnect

• Task C, Configure Connections to Responder TIBCO BusinessConnect

Task A Open the BusinessWorks Project

To open the TIBCO ActiveMatrix BusinessWorks project in TIBCO Business Studio:

1. Start TIBCO Business Studio.

2. Click File > Import. 

3. On the Import page, expand the General folder and select the Existing Studio 
Projects into Workspace item. Click Next. 

4. Click Browse next to the Select archive file field to navigate to the ezcomm_for_bw6.zip 
file. Click Finish. 

The sample project is located in the BC_HOME/protocols/ezcomm/samples/tutorial directory.

After importing the sample, you also need to do the following steps:

1. Expand Module Descriptors in the Project Explorer view.

2. Double-click Module Properties.

The the Module Properties editor is displayed.

3. In the User tab, change the default value of the BC_HOME_DIR property to your 
BC_HOME. By default, the vaule is D:/tibco/bc/.

Task B Configure Connections to Initiator TIBCO BusinessConnect

To configure connections to TIBCO BusinessConnect on the Initiator computer:

1. In the Project Explorer view, click Resources > ezcomm_demo> 
INITIATOR.bcResource.

2. Click the Server Access tab.

3. Enter information as explained in Table 9.
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4. Click Update from Configuration Store in the Configuration tab.

5. Select EZComm from the Protocol Name list.

If you select the Select Operations check box, you could select any of the 
configured/imported operations. For this tutorial, select all operations and click OK.

6. Click Import Selected Business Protocol. 

When you import the protocol, BusinessWorks retrieves information from the TIBCO 
BusinessConnect configuration store and puts them in the project folder.

7. Click Save.

Task C Configure Connections to Responder TIBCO BusinessConnect

On the Responder computer, complete all steps explained in Task B, Configure 
Connections to Initiator TIBCO BusinessConnect, page 21, replacing all instances of 
Initiator with Responder.

Running the Tutorial 
To see the complete tutorial for the Asynchronous Request Response operation, you must 
run it on both computers, Buyer and Seller. 

Running the Tutorial on the Seller Computer

1. In TIBCO Designer, expand the RESPONDER folder.

2. Click Asynchronous Request Response > Receive Async Request.

3. Click Read File > Input Tab > ReadActivityInput and verify that the path given in 
the fileName field is valid.

4. Click the Tester tab.

5. Click Start testing viewed process .

The Select Process to Load page is displayed.

• You can also run the Synchronous Request Response and Notify transactions using the 
processes provided in this tutorial.

• The steps of how to load and run private processes in TIBCO Business Studio are 
similar to TIBCO Designer. See TIBCO ActiveMatrix BusinessWorks Documentation 
for more details.
TIBCO BusinessConnect Services Plug-in User’s Guide



Tutorial Steps | 23
Figure 4   Select Process to Load

6. Select the Receive Async Request(current) check box.

7. Click Load Selected.

Once the request is received from the Buyer computer, this process receives the 
RESPODER.REQUEST message and then send the RESPONDER.RESPONSE 
message to TIBCO BusinessConnect.

Running the Tutorial on the Buyer Computer

1. In TIBCO Designer, click INITIATOR > Asynchronous Request Response.

2. Click the Send ASync Request process.

3. Click the SendRequest activity.
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Figure 5   SendRequest (Input)

4. Enter Buyer in the fromTP field and Seller in the toTP field in the Input Tab, as shown in 
Figure 5.

5. Click Read File > Input Tab > ReadActivityInput and verify that the path given in 
the fileName field is valid.

6. Click Apply and Save.

7. Click the Tester tab.

8. Select two processes: 

— INITIATOR/Asynchronous Request Response/Send Async Request 

— INITIATOR/Asynchronous Request Response/Receive Response processes.

9. Click Load selected.

10. On the Tester page, select the Send ASyncRequest operation and click Create a job.
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Figure 6   Create Job for the Send ASyncRequest operation

It sends an INITIATOR.REQUEST to the INITIATOR TIBCO BusinessConnect. At 
the same time, the Receive Response activity receives the INITIATOR.RESPONSE 
message.

Figure 7   Send INITIATOR.REQUEST and Receive INITIATOR.RESPONSE

Figure 8   Send Async Request
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Figure 9   RESPONDER AsynchronousRequestResoponse Process
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Chapter 3 Services Plug-in URIs

This chapter provides more detailed information about the Services Plug-in URIs.

Topics

• Exchanging URIs, page 28
 TIBCO BusinessConnect Services Plug-in User’s Guide
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Exchanging URIs

Trading partners must exchange Uniform Resource Identifiers (URIs) as part of the 
business agreement before they can transact e-commerce. 

For the Services Plug-in, the URI, the subject, and the headers can encode information 
about the from trading partner, to trading partner, and the operation ID of the transaction. 
For an outgoing HTTP message, Business Connect always populates these values in an 
HTTP URL. However, for an incoming HTTP message it can interpret these values from 
an HTTP header or an HTTP URL, in that order.

Additional information in the URI, such as toTP and fromTP, is available only for transports 
other than AS1, AS2, or EMAIL, since the same information is derived from the internet 
headers such as AS2 TO/FROM ID and the EMAIL FROM/TO address. Such information becomes 
redundant and ambiguous if provided in the URI.

Available transports and their URI formats are listed in this section.

Email Transport
The URI format is mailto://username@domain, such as mailto://john@acme.com

When using Email transport, you have the option of specifying the mail subject. If the 
subject contains the string operationID=”category/version_number/operation_name” then 
OperationID is taken as the operation ID for that transaction. 

If the operation ID is not specified in the subject, then the value is what is sent by the 
private process.

File Transport
The URI format is file://BaseDir/*.*

This causes all directories under BaseDir to be checked for files. In order for the file to be 
handled by the Services Plug-in, the document must appear as follows:

• Default behavior, such as for the operation BC/version/Notify:

BaseDir/EZComm/TpName

• Non-default behavior, for other operations:

BaseDir/EZComm/TpName/Category_version_OperationID

The Services Plug-in populates trading partner and operation information in the outgoing 
URI only if the URI ends with /EZComm.
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where BaseDir is a user selected base directory, TpName is the name of the trading 
partner, Category is the operation category, version is the operation version, and 
OperationID is the operation ID. 

If OperationID is not provided, then it defaults to BC/version/Notify.

You should provide a file mask *.* for a file. Otherwise, the file is not picked up by the 
File transport.

FTP Transport
URI format ftp://server:port/dir. dir can be anything or absent. 

You should provide a file mask *.* for a file. Otherwise, the file is not picked up by the 
FTP transport.

HTTP/S Transport

URI for the HTTP Transport

URI format: http://server:port/dmz/EZComm

Example: http://www.gizmo.com:555/dmz/EZComm

For HTTP transport, the partner name, host name, and operation ID can be specified as 
parameters in the request URI or as transport headers.

The parameters or headers that the Services Plug-in expects are as follows:

• fromTp   This is a required field for the incoming message.

• toTp  If this parameter is missing, it defaults to the default host.

• operationID   If this parameter is missing, it defaults to BC/version_number/Notify.

• fileName   If you specify the parameters in the URI, the format is:

A file name can be specified in the file mask field. See TIBCO BusinessConnect Trading 
Partner Administration Guide, Table 41, Outbound File Transport for information about 
how to specify the file mask field in File transport.

A file name can be specified in the file mask field. See TIBCO BusinessConnect Trading 
Partner Administration Guide for information about how to specify the file mask field in 
FTP transport.

With the Services Plug-in, FTP inbound transactions always defaults to the 
BC/version/Notify operation.
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http://host:port/dmz/EZComm?fromTp=fromTP&toTp=toTP&operationID=opID&fileName=fileName

URI for the HTTPS Transport

URI format: https://server:port/dmz/EZComm

Example: https://www.gizmo.com:555/dmz/EZComm

Populating URIs

URIs are populated as follows:

• On the outbound side, URI fields have precedence over the headers. 

• On the inbound side, if values are specified in headers as well as URI places, the 
transport headers take precedence over the request URI values.

The fileName feature is not supported for the AS2-HTTP transport.

BusinessConnect 6.x still supports the older BusinessConnect 5.x URI format 
http://server:port/EZComm (or https://server:port/EZComm) for backward compatibility, but is 
deprecated starting with the BusinessConnect 6.0 release.

The AS2 specification does not support custom headers.
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Chapter 4 Managing Services Plug-in Operations

This chapter describes how to manage the Services Plug-in operations.

Topics

• Overview, page 32

• Notify Operation, page 35

• Synchronous Request Response Operation, page 36

• Asynchronous Request Response Operation, page 37

• Configuring Services Plug-in Operations, page 39
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Overview

The exchange of business documents is known as the process flow. In any 
BusinessConnect process flow, two types of messages are exchanged:

• Public messages or operations

• Private messages. See Private Messages, page 68.

About Services Plug-in Operations
Public messages are exchanged over the Internet between BusinessConnect and another 
B2B installation. The following message types are supported in the Services Plug-in:

• Notify Operation, page 35

• Synchronous Request Response Operation, page 36

• Asynchronous Request Response Operation, page 37

About Schema Validation in the Services Plug-in
Schema validation in the Services Plug-in is performed based on the following:

• Schema type: XSD or DTD 

• Direction of messages

• Whether the validation is done for a request or for a response

Caching of Schemas

The referenced schema is updated in the validator cache during runtime validation, in the 
same way as if it was saved through the GUI.

When a schema is used by reference, you do not observe any schema changes in the 
referenced object but you could see the change on the reference instead. This means that 
the TIBCO BusinessConnect configuration store does not scan the referenced object each 
time the validation occurs, but it instead indicates if there is a change in the uploaded file 
object. You need to update the reference in the GUI — re-save the schema reference — 
and the new referenced object is updated in the cache. 

See also Validation Schema Name, page 42 for more information about how to choose 
which schema to use: XSD or DTD.
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Duplicate Message Detection
The Services Plug-in allows both incoming and outgoing public messages to be verified 
for duplicates. A message is determined to be a duplicate based on the certain message 
field values such as transactionID, operationID , and so on. 

For each message, a message digest from the predetermined fields is created and stored in 
a table. If any subsequent message has the same message digest, it is considered to be a 
duplicate message. If requested by the user, all incoming requests are checked for 
duplicates. 

Both the inbound and outbound requests for a trading partner can be configured for the 
duplicate detection. 

If the duplicate detection for the outbound messages is enabled, all the incoming private 
process messages are checked for duplicate detection. If a request is found to be a 
duplicate, the transaction is terminated and an error advisory is sent to the private process.

For the inbound requests, the private process is notified by setting the duplicate field to 
true, while it is up to the private process to take further action.

Outbound Duplicate Detection Criteria

The following fields from the private process are used in calculating the message digest 
for duplicate detection for outbound requests:

• TransactionID received from the user

• Payload: plainRequest, binaryRequest, inputFileName (file content)

• Trading partner host name

• Operation ID

• Host name

For asynchronous and synchronous responses, outbound duplicate detection is not 
supported (only inbound duplicate detection is supported).

When the outbound File poller initiates a transaction, the transactionID element is used for 
calculating the message digest.
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Inbound Duplicate Detection Criteria

The following values from the incoming request are used in calculating the message digest 
for duplicate detection for inbound requests.

• Payload 

• Trading partner name

• Operation ID

If an error occurs during the transaction processing, the duplicate detection entry from the 
table BC_DUP is deleted.

For asynchronous and synchronous responses, only inbound duplicate detection is 
supported.
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Notify Operation

Notify is a one way operation that simply sends a document to the trading partner and 
receives an acknowledgement: it is not capable of receiving a response from the trading 
partner. 

The operation flow in a Notify operation is shown in Figure 10.

Figure 10   Notify Operation

The following process flow occurs with the Notify operation:

1. The Initiator private process sends a message to the Initiator TIBCO 
BusinessConnect. 

2. The Initiator TIBCO BusinessConnect retrieves relevant information and sends the 
message to the Responder TIBCO BusinessConnect.

3. The Responder TIBCO BusinessConnect immediately sends a transport response 
(acknowledgment) to the Initiator TIBCO BusinessConnect on the same channel as 
the Initiator business request.

4. The Responder TIBCO BusinessConnect then forwards the message to the local 
private process. 

See Responder Inbound Request — BusinessConnect to Private Process. The 
Responder TIBCO BusinessConnect considers the operation as complete.

5. The Initiator TIBCO BusinessConnect sends an INITIATOR.RESPONSE message to 
the private process. 

See Initiator Inbound Response — BusinessConnect to Private Process. This message 
is sent independently from the Responder TIBCO BusinessConnect, which sends a 
RESPONDER.REQUEST message to the Responder private process. 

Supported Transports for the Notify Operation are: HTTP, HTTPS, HTTPSCA, File, FTP, 
FTPS, SSHFTP, Email, AS1, and AS2.
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Synchronous Request Response Operation

The Synchronous Request Response operation can send a document to the trading partner 
and wait for a response. It waits until the response is received and suspends any further 
processing for that request. This operation is used to send documents to trading partners 
and require response for further processing to proceed. The operation flow is presented in 
Figure 11.

Figure 11   Synchronous Request-Response Operation

1. The Initiator private process sends the request to the Initiator.

2. The Initiator sends the request to the Responder and waits for the response until the 
timeout specified in the appropriate transport has expired.

3. The Responder TIBCO BusinessConnect sends the request to the Responder private 
process. 

4. The Responder private process send a response. If the private process does not 
respond on time, the Responder TIBCO BusinessConnect times out and ends the 
transaction. If the response from the private process arrives after this time out, the 
message is rejected and an error is thrown.

5. The response is forwarded to the Initiator TIBCO BusinessConnect.

6. The Responder acknowledgement is sent to the private process indicating whether the 
response has been forwarded to the trading partner. It does not indicate whether the 
trading partner has received it or not.

7. Upon receiving the response from the Responder, the Initiator sends the Initiator 
Response message. If the Initiator times out, an audit log entry is generated, a timeout 
error advisory is sent, and the connection is closed.

Supported transports are: HTTP, HTTPS, and HTTPSCA. 

Resending of Responder.Request and Responder.Response for the Synchronous Request 
Response operation is not supported for the Services Plug-in.
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Asynchronous Request Response Operation

The asynchronous Request Response operation can send a document to the trading partner 
and wait for a response. It allows further processing, irrespective of the arrival of the 
response from the partner. 

Figure 12 shows what happens when you run an asynchronous Request Response 
operation.

Figure 12   Tutorial: Asynchronous Request Response Operation

The following process flow occurs:

1. The Initiator private process sends a request to the Initiator TIBCO BusinessConnect.

2. The Initiator TIBCO BusinessConnect sends the request to the Responder and waits 
for the response until the timeout specified in the operation has expired.

3. The Responder TIBCO BusinessConnect sends a request to the Responder private 
process. 

4. The Responder private process sends the response. If the private process does not 
respond on time, the Responder TIBCO BusinessConnect would time out and end the 
transaction. 

If the response from the Responder private process arrives after the timeout, the 
message is rejected and an error advisory is sent. 

5. If the response from Responder private process is received on time, the response is 
forwarded to the Initiator TIBCO BusinessConnect.

6. A Responder acknowledgement is sent to the Responder private process indicating 
whether the response has been forwarded to the trading partner. 

7. After receiving the response from the Responder, the Initiator sends the Initiator 
Response message.

If the Initiator TIBCO BusinessConnect times out, an audit log entry is generated and 
a timeout error advisory is sent out. In this case, the request is cancelled. When the 
response arrives at a later time, there is not any corresponding request present, the 
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advisory is rejected, an error advisory is published, and an internal system error is sent 
to the partner.

Supported transports are: HTTP, HTTPS, HTTPSCA, AS2_HTTP, Email, and 
AS1_EMAIL. 

Resending of Responder.Response is not supported for the asynchronous Request Response 
operation.

Resending of Responder.Request is supported for the asynchronous Request Response 
operation. It can generate a response from the private process that is not sent to the trading 
partner. In this case, a proper error message and an audit log is generated.
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Configuring Services Plug-in Operations

To configure a Services Plug-in operation:

1. Start TIBCO Administrator.

2. Click BusinessConnect > Operations Editor.

On the Operations Editor page, group the available installed protocols (plug-ins) by 
Plug-in or None.

Figure 13   Configure New Operation for the Services Plug-in

Using this page to:

— Import a new operation by clicking Import.

— Export the existing operations, by selecting the radio button next to the plug-in and 
clicking Export.

Add New Category
Category is used to group operations based on their type.

1. Click the EZComm link. 

The Edit Operations: EZComm page is displayed.

2. Click New Category. 

3. On the New Category page:

— In the Name field, type a category name (required).

— In the Description field, type a brief description for this category (optional).

4. Click Save.
 TIBCO BusinessConnect Services Plug-in User’s Guide



40 | Chapter 4  Managing Services Plug-in Operations
Add New Version
Version is used to allow various subgroups of operations, such as Notify only, or Notify and 
Synchronous Request Response, and so on.

1. Click New Version with the category selected.

2. On the New Version page:

— In the Name field, type a version name (required)

— In the Description field, type a brief description for this version (optional).

3. Click Save.

Add New Operation
Operations are added to a specific version. Each version can contain the same or different 
operation sets.

1. Click New Operation with the a version selected.

The New Operation page is displayed.

Figure 14   New Operation Dialog

2. Select one operation from the Operation Type list:

— Synchronous/Asynchronous Request-Response Operation Tab

— Notify

3. Click OK.

Synchronous/Asynchronous Request-Response Operation

The two operations are configure in a similar way, with small differences that are pointed 
out in the instructions.

To configure the Synchronous Request-Response operation, the following tabs are used:

• Synchronous/Asynchronous Request-Response Operation Tab

• Request Action Tab
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• Response Action Tab

Synchronous/Asynchronous Request-Response Operation Tab

In the Synchronous Request-Response Operation tab, enter information according to 
Table 10.

Click Save.

Request Action Tab

In the Request Action tab, enter information according to Table 11.

Table 10   Synchronous/Asynchronous Request-Response Operation Tab

Field Enter/Select

Name Name of the operation (required).

Description Brief description for the operation.

Inbound

Validate Message When selected, any inbound messages (either request or response), are validated. This 
should be selected in the following cases:

• If the Initiator needs the response from the partner to be validated.

• If the Responder needs the request to be validated.

Outbound

Validate Message When selected, either the request or response is validated. This check box should be 
selected in the following cases:

• Initiator needs that the request to the partner be validated.

• Responder needs that the response be validated.

Table 11   Request Action Tab 

Field Enter/Select

Name Name of the request action.

Description Brief description for the request action. 

Direction Initiator to Responder (pre-defined).
 TIBCO BusinessConnect Services Plug-in User’s Guide



42 | Chapter 4  Managing Services Plug-in Operations
Click Save.

Validation Schema 
Name

Either XSD or DTD schema can be defined. The file selected here should match 
the validation type selected in the field XML Document Validation. 

To select a schema document:

1. Click the change link.

2. On the Change File page, select one of the following two from the Type list:

File Reference   If you select File Reference, enter the path to the .xsd file you 
want to use.

Uploaded File   If you select Uploaded File:

a. Click Browse and navigate to the schema file. In this tutorial, it is located 
in the directory BC_HOME\protocols\ezcomm\samples\sampleXML\xsd.

Note: The Services Plug-in supports XSD and DTD schema validation. In 
this tutorial, the XSD validation is used.

b. Click Open.

c. Click OK.

Require Digital 
Signature

Used for both HTTP and HTTPS transports. If selected, this option signs the 
outgoing messages and force the incoming messages to be signed. 

Require Content 
Encryption

Used for both HTTP and HTTPS transports. If selected, this option encrypts the 
outgoing messages and force the incoming messages to be encrypted. 

Wait time for Response 
(seconds)

This field is available only for the asynchronous Request-Response operation. 

The default is 3600 seconds.

For BC Palette use only

XML Document 
Validation

Select XSD or DTD from the XML Document Validation list.

Root XML Element 
Name

Root XML element name, which is the top-level XML element in the document. It 
is only required if you are going to use the TIBCO BusinessConnect palette.

Table 11   Request Action Tab (Cont’d)

Field Enter/Select
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Response Action Tab

On the Edit Operation page, enter information according to Table 12.

Click Save.

This tab is not available for the Notify operation.

Table 12   Response Action Tab

Field Enter/Select

Name Name of the response action.

Description Brief description for the response action. 

Direction Responder to Initiator (pre-defined).

Validation 
Schema Name

Either XSD or DTD schema can be defined. File selected here must match the 
validation type selected in the field XML Document Validation. 

For more information about how to select the schema document, see Validation Schema 
Name, page 42.

Require Digital 
Signature

Used for both HTTP and HTTPS transports. If selected, this option signs the outgoing 
messages and force the incoming messages to be signed. 

Require Content 
Encryption

Used for both HTTP and HTTPS transports. If selected, this option encrypts the 
outgoing messages and force the incoming messages to be encrypted. 

Private Process 
Wait (seconds)

Specifies the amount of time that the Responder waits for the response from the private 
process. 

The default is 3600 seconds (60 minutes).

For BC Palette use only

XML Document 
Validation

Select XSD or DTD from the XML Document Validation list.

Root XML 
Element Name

Root XML element name, which is the top-level XML element in the document. It is 
only required if you are going to use the TIBCO BusinessConnect palette.
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Notify Operation

To configure the Notify operation, the following tabs are used:

• Notify Operation Tab

• Notify Request Action Tab

Notify Operation Tab

In the Notify Operation tab, enter information according to Table 13.

Click Save.

Notify Request Action Tab

In the Request Action tab, enter information according to Table 14.

Table 13   Notify Operation Tab

Field Enter/Select

Name Name of the operation (required).

Description Brief description for the operation.

Inbound

Validate Message When selected, any inbound messages (either request or response), are validated. This 
should be selected in the following cases:

• If the Initiator needs the response from the partner to be validated.

• If the Responder needs the request to be validated.

Outbound

Validate Message When selected, either the request or response is validated. This check box should be 
selected in the following cases:

• The initiator needs that the request to the partner be validated.

• The responder needs that the response be validated.

Table 14   Request Action Tab 

Field Enter/Select

Name Name of the request action.
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Description Brief description for the request action. 

Direction Initiator to Responder (pre-defined).

Validation Schema 
Name

Either XSD or DTD schema can be defined. The file selected here should match 
the validation type selected in the field XML Document Validation. 

To select the schema document:

1. Click the change link.

2. On the Change File page, select one of the following from the Type list:

• File Reference   If you select File Reference, enter the path to the .xsd file you 
wish to use.

• Uploaded File   If you select Uploaded File:

a. Click Browse and navigate to the schema file. 

In this tutorial, it is located in the 
BC_HOME\protocols\ezcomm\samples\sampleXML\xsd directory.

Note: The Services Plug-in supports XSD and DTD schema validation. In 
this tutorial, the XSD validation is used.

b. Click Open.

c. Clock OK.

Require Digital 
Signature

Used for both HTTP and HTTPS transports. If selected, this option signs the 
outgoing messages and force the incoming messages to be signed. 

Require Content 
Encryption

Used for both HTTP and HTTPS transports. If selected, this option encrypts the 
outgoing messages and force the incoming messages to be encrypted. 

Wait time for Response 
(seconds)

This field is available only for the asynchronous Request-Response operation. 

The default is 3600 seconds.

For BC Palette use only

XML Document 
Validation

Select XSD or DTD from the XML Document Validation list.

Root XML Element 
Name

Root XML element name, which is the top-level XML element in the document. It 
is only required if you are going to use the TIBCO BusinessConnect palette.

Table 14   Request Action Tab (Cont’d)

Field Enter/Select
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Click Save.
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Chapter 5 Managing Properties

This chapter explains how to add and remove the Services Plug-in properties.

Topics

• Managing Services Plug-in Properties, page 48
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Managing Services Plug-in Properties

You can add, change, or remove Services Plug-in properties using the Edit Plug-in 
Properties dialog. 

To view, add, or delete a property:

1. In TIBCO Administrator, click BusinessConnect > System Settings > Activated 
Protocol Plug-ins and Properties.

2. Click EZComm.

The following Services Plug-in properties are displayed:

— ezcomm.notify.email.preserveSubject   Preserve Email Subject specified by the 
user. 

When sending email messages for EMAIL and AS1 transports, TIBCO 
BusinessConnect Services Plug-in generates the email subject based on operation 
and transaction IDs. However, it is possible to preserve the subject specified by the 
user on EMAIL and AS1 transports by enabling the property 
ezcomm.notify.email.preserveSubject. By setting this property to true, users can send their 
own email subject to trading partners.

— ezcomm.interior.pp.threshold   Private Process SkipContent Threshold (KB)

Enter the threshold value. The default is 10000 KB.

— ezcomm.outbound.ftp.write.payload.tofile    Preserve Payload to be written to 
file for FTP Puts.

Select the check box to preserve payload. The default is unchecked.

Add a Property

1. Click Add.

2. Type a name for the property in the Property Name field.

3. Select a data type from the Property Type list: boolean, string or integer.

4. Type a description of the new property in the Description field.

5. Click Save.

Delete a Property

1. Click Delete.

You can remove only user defined properties; the default properties should not be 
removed.
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2. Type the name of the property you want to delete and click OK.
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Chapter 6 Setting Up Trading Hosts and Partners

This chapter explains how to set up trading hosts and partners for TIBCO 
BusinessConnect Services Plug-in.

Topics

• Configuring Services Plug-in for a Host, page 51

• Configuring Services Plug-in for a Partner, page 53
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Configuring Services Plug-in for a Host

To configure the default host in a business agreement:

• Configuring the Initiator Default Host, page 51

• Assigning Default Host for Initiator, page 52

Configuring the Initiator Default Host
1. Click BusinessConnect > Participants.

2. Click New.

3. On the New Participant page, type the host’s name in the Name field.

4. Select Host in the Type list.

5. Click OK.

6. Click the host link.

7. On the Edit Host Participant page, select the Active check box. 

8. Click Apply.

9. On the Edit Host Participant page, click the Protocols tab.

10. Click the EZComm link. 

Select or enter the information according to Table 15. 

11. Click Save.

Table 15   Host Settings: General Tab 

Field Description

AS2 Identifier An identifier to use in the AS2-From header field of the HTTP message. 

This identifier should be mutually agreed upon between trading partners. 

For more information about AS2 Identifiers, see TIBCO BusinessConnect Server 
Administrator’s Guide, Disabling Session Cache for HTTPS.

Valid Email 
Address List

Enter the list of valid email addresses for this participant, separated by a semicolon or 
comma. 

For details, see TIBCO BusinessConnect Trading Partner Administration Guide.
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Assigning Default Host for Initiator
1. Click BusinessConnect > System Settings.

2. Click the General link.

3. On the General page, select the appropriate host in the Default Host list.

4. Click Save.
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Configuring Services Plug-in for a Partner

To configure a partner in a business agreement:

1. Click BusinessConnect > Participants.

2. Click New.

3. On the New Participant page, type a partner’s name in the Name field.

4. Select Partner in the Type list.

5. Click OK.

Both the Buyer (Host) and Seller (Partner) now are displayed on the Participants 
panel.

6. Click the partner link.

7. On the Edit Host Participant page, select the Active check box. 

8. Click Apply.

Enabling Protocol for Initiator Partner
1. On the Edit Partner Participant page, click the Protocols tab.

2. Click Enable. 

The Enable page with installed protocols is displayed. 

3. Select the EZComm check box.

4. Click OK.

The EZComm protocol is now in the Protocol Name list.

5. Click the EZComm link.

The Edit Enabled Protocol: EZComm page is displayed with the following tabs:

— General Tab

— Transports Tab
 TIBCO BusinessConnect Services Plug-in User’s Guide
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General Tab

Select or enter information as explained in Table 16. 

Click Save.

Table 16   Partner Settings: General Tab

Field Description

AS2 Identifier An identifier to use in the AS2-To header field of the HTTP message. This identifier 
should be mutually agreed upon between trading partners. 

For more information about AS2 Identifiers, see TIBCO BusinessConnect Trading 
Partner Administration Guide, Disabling Session Cache for HTTPS.

Valid Email 
Address List

Enter the list of valid email addresses for this participant, separated by a semicolon or 
comma. 

For details, see TIBCO BusinessConnect Trading Partner Administration Guide, 
Table 28, Configuring HTTP/S for a Trading Partner: General Tab.

Allow override of 
filename via HTTP 
parameter

If this check box is selected, and a file reference is being passed from the private 
process, then the name of the file is passed on to the Responder in an HTTP header 
called filename.

This property also applies for the Inbound transports, specifically, when AS2 headers 
have the filename embedded that are sent to the private process.

For more information, see Allow override of filename via HTTP parameter (applies 
only to HTTP/S transports).

Duplicate Detection 
for Outbound

If selected, all incoming private process messages and the outgoing responses are 
checked for duplicate detection. 

If a request is found to be a duplicate, the transaction is terminated and an error 
advisory is sent.

Duplicate Detection 
for Inbound

All incoming requests for Responder and Initiator are checked for duplicates. 

If any duplicates are found, the duplicate field in the private process message is set to 
true.
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Transports Tab

To add a transport for the partner:

1. Click the Transports tab.

2. Click Add. 

Enter data for the new transport as explained in Table 17.

3. Click OK.

Define URL

To define the URL for the partner, enter the following information:

URL (required): www.hostname:6700/dmz/EZComm.

Table 17   New Transport for the Partner

Field Description

Name Enter the name for the transport (required).

Type Select the transport type from the Type list.

To configure a specific transport for the partner, see TIBCO BusinessConnect Trading 
Partner Administration Guide, and then refer to the appropriate chapter for the 
transport .
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Chapter 7 Configuring Business Agreements

This chapter explains how to configure business agreements and protocol bindings for the 
Services Plug-in.

Topics

• Adding a New Business Agreement, page 58

• Configuring Agreement Protocol Binding for Services Plug-in, page 59
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Adding a New Business Agreement

After both trading partners are configured, you can now configure their business 
agreement:

1. Click BusinessConnect > Business Agreements.

2. Click New. 

The New Agreement page is displayed.

Verify that the plug-in is displayed in the Protocols column for both trading partners 
between which you want to configure a business agreement. If it is missing, return 
back to Enabling Protocol for Initiator Partner, page 53 and enable it.

3. Select a host from the Host Party list.

4. Select a partner from the Partner Party list

5. Click OK. 

The New Agreement page is displayed.

6. Confirm that the Valid check box is selected. It makes the agreement valid 
immediately.

If you want to make the agreement valid for a certain time period, do the following:

— Use the Start Date lists to specify the start date.

— Use the End Date lists to specify the stop date. This date has to be later than the 
start date.
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Configuring Agreement Protocol Binding for Services Plug-in

To configure Services Plug-in agreement protocol bindings:

1. On the New Agreement page, click Add Protocol Bindings. 

2. On the Select Protocol page, select the EZComm check box.

3. Click OK. 

The New Agreement page is displayed.

4. Click the EZComm link in the Agreement Protocol Binding list. 

The following tabs for configuring protocol binding options are available:

— Operation Bindings Tab

— Document Security Tab

— Transports Tab

— Show Advanced Tab

Operation Bindings Tab
Use the Operations Binding tab to configure the Services Plug-in operations that each 
participant in a business agreement can initiate and respond to.

The Host ’X’ Can Initiate and Partner ’Y’ Can Initiate areas list the activities that the 
host/partner can initiate and the partner/host can respond to. 

1. Enter information according to Table 18.

2. In the Initiating Operations section, click Add Operation Binding.

3. Expand the operation tree and select the operation.

4. Click OK.

Table 18   Edit Protocol Binding: Operation Binding Tab

Field Description

Allow All 
Operations

If the check box is selected, you do not need to specify operation bindings that the 
host or partner can initiate. 

If the check box is cleared, you need to define the specific operation bindings.

Non-Repudiation 
Logging

The non-repudiation log is used to provide proof of the delivery of messages. 

For details, see TIBCO BusinessConnect Concepts, Non-Repudiation.
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The selected operation is displayed in the Operation Name list.

Edit Operation Bindings for the Host

Click the operation in the Initiating Operations section. The following tabs for 
configuring options are available:

• Operation Settings Tab

• Action Settings Tab

• Transports Tab

Operation Settings Tab

Override the operation settings as shown in Table 19.

Click Save or Cancel (if no changes have been made).

Table 19   Override Outbound Settings: Operation Settings Tab (All Operations)

Field Description

Override 
Operation Settings

Select the check box to override the operation settings for this operation. These settings 
have been previously configured, as explained in Importing the Tutorial.

Note   When a BusinessConnect server acts as the Initiator, the transport for sending an 
outbound document can be overridden for all operation types bound in this section. 
Such overriding does not apply to the outbound responses of an Asynchronous Request 
Response operation in cases when the BusinessConnect server acts as the Responder.

Inbound

Validate Message When selected, an inbound messages (either request or response) are validated. This 
should be selected in the following cases:

• If the Initiator needs the response from the partner to be validated.

• If the Responder needs the request to be validated.

Outbound

Validate Message When selected, either the request or response is validated. 

This check box should be selected in the following cases:

• Initiator needs that the request to the partner be validated

• Responder needs that the response be validated
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Action Settings Tab.

Override the action settings using Table 20.

Click Save or Cancel (if no changes have been made).

Transports Tab

Configure transport settings as shown in Table 21.

Click Save or Cancel (if no changes have been made).

Table 20   Override Outbound Settings: Actions Tab (Notify and Asynchronous Request-Response Operations) 

Field Description

Override Action 
Settings

Select the check box to override the originally configured action settings for the host.

Require Digital 
Signature

( Notify operation with HTTP and HTTPS transports only )

Select to override the originally configured signature settings for the host.

Require Content 
Encryption 

( Notify operation with HTTP and HTTPS transports only )

Select to override the originally configured encryption settings for the host.

Wait Time for 
Response (seconds)

(Asynchronous Request-Response operation only)

Select to override the originally configured Wait time for the Initiator. The default is 
3600 seconds (60 minutes).

Table 21   Override Outbound Settings: Transports Tab (All Operations)

Field Description

Override Transports Select the check box to override the originally configured transport for the host.

Override Outbound Transports

Primary Transport Select any of the transports previously configured for the partner.

See Add Transport for the Initiator Partner, page 10 for details.
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Edit Operation Bindings for a Partner

Click the operation in the Responding Operations section. The following tabs for 
configuring options are available:

• Operation Settings Tab

• Action Settings Tab

• Transports Tab

Operation Settings Tab

Override the operation settings as shown in Table 22.

Click Save or Cancel (if no changes have been made).

When a BusinessConnect sever acts as the Responder, the transport for sending an 
outbound document can only be overridden when sending the response for asynchronous 
operation types bound in this section.

Table 22   Override Inbound Settings: Operation Settings Tab (All Operations)

Field Description

Override 
Operation Settings

Select the check box to override the operation settings for this operation. These settings 
have been previously configured, as explained in Importing the TutorialI. 

Inbound

Validate Message When selected, an inbound messages (either request or response) are validated. This 
should be selected in the following cases:

• If the Initiator needs the response from the partner to be validated.

• If the Responder needs the request to be validated.

Outbound

Validate Message When selected, either the request or response is validated. 

This check box should be selected in the following cases:

• Initiator needs that the request to the partner be validated

• Responder needs that the response be validated
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Action Settings Tab

To configure either the Synchronous or Asynchronous Request Response operation, click 
the Action Settings tab and override the action settings as shown in Table 23.

Click Save or Cancel (if no changes have been made).

Transports Tab

Override transport settings as shown in Table 24.

Click Save or Cancel (if no changes have been made).

Document Security Tab
To learn how to edit this tab, see TIBCO BusinessConnect Trading Partner Administration 
Guide, Document Security Tab. 

See also TIBCO BusinessConnect Concepts, Chapter 8, Security.

Table 23   Override Inbound Settings: Actions Tab (Synchronous and Asynchronous Request Response)

Field Description

Override Action 
Settings

Select to override the originally configured action settings for the partner.

Private Process 
Wait (seconds)

Select to override the originally configured Wait time (amount of time the Responder 
waits for the response from the private process). 

The default is 3600 seconds (60 minutes).

Table 24   Override Inbound Settings: Transports Tab (All Operations)

Field Description

Override 
Transports

Select the check box to override the originally configured transport for the partner.

Note   For the Synchronous Request Response operation, this option is invalid.

Override Outbound Transports

Primary Transport Select any of the transports previously configured for the partner. 
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Shadow Credential Usage for the Services Plug-in

Sending Signed or Encrypted Messages

When sending signed or encrypted messages over HTTP, HTTPS, or HTTPSCA 
transports, you can use shadow credentials during overlay and shadow credential period to 
sign or encrypt these messages.

Receiving Signed or Encrypted Messages

When receiving signed or encrypted messages from a trading partner over HTTP, HTTPS, 
or HTTPSCA transports, credentials are picked during the overlay period in the following 
order: 

a. Shadow credential is tried for authentication or decryption.

b. If this fails, the original credential is tried.

For the shadow credential period, only the shadow credential is tried.

Transports Tab
The Transports tab is divided in two sections as follows:

• The top section is used for specifying transport information for the outbound, or host 
to trading partner, direction.

• The bottom section is used for specifying transport information for the inbound, or 
trading partner to host, direction.

Configure transports for the host according to Table 25.

Table 25   Configure Transports for the Host 

Field Description

Outbound Transports for Host

Primary Transport Select the outbound transport that was previously configured.

See Add Transport for the Initiator Partner for more details.

AS2 MDN Async 
Reply Transport

Select any of the configured transports.

For more information, see TIBCO BusinessConnect Trading Partner 
Administration Guide.
TIBCO BusinessConnect Services Plug-in User’s Guide



Configuring Agreement Protocol Binding for Services Plug-in | 65
Click Save twice.

Show Advanced Tab
The Show Advanced tab on the Edit Protocol Bindings page allows you to configure 
additional settings for the host in a business agreement.

1. Click Show Advanced. 

The Edit Protocol Bindings page is displayed with two additional tabs: Host’s 
Configuration and Partner’s Configuration.

2. To hide the Host’s and Partner’s Configuration tabs, click Hide Advanced.

Override Settings for the Host

To override general settings for the host:

1. Select the tab representing the host. 

AS2 Async MDN 
Remote Server 
Certificate

For more information, see TIBCO BusinessConnect Trading Partner 
Administration Guide.

Client Authentication 
Identity for HTTPS, 
FTPS, HTTPSCA

For more information, see TIBCO BusinessConnect Trading Partner 
Administration Guide.

Client Authentication 
Identity for SSHFTP

For more information, see TIBCO BusinessConnect Trading Partner 
Administration Guide, Edit Protocol Bindings: Transports Tab.

Allowed Inbound Transports for Partner

(list of configured 
partner transports)

Select the appropriate check boxes to allow certain inbound transports for the 
partner.

Table 25   Configure Transports for the Host (Cont’d)

Field Description
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2. Enter or select information according to Table 26.

3. Click Save.

Override Settings for the Partner

To override general settings for the partner:

1. Select the tab representing the partner. 

2. Enter or select information according to Table 27.

Table 26   Edit Protocol Bindings: Advanced Settings for Host

Field Description

Override Settings If you select the Override Settings check box, it overrides the values set on the host 
level: the AS2 Identity selected from the AS2 Identifier list is used to override the 
default AS2 identity for the host configured by using the procedure described in the 
following sections:

• TIBCO BusinessConnect Trading Partner Administration Guide, Set the Host’s 
AS2 Identifier for a Protocol.

• TIBCO BusinessConnect Trading Partner Administration Guide, Disabling 
Session Cache for HTTPS.

If you clear the Override Settings check box, the default AS2 identity for the host 
remains valid.

AS2 Identifier Select an AS2 identity that is used to override the default AS2 identity.

Table 27   Edit Protocol Binding: Advanced Settings for Partner 

Field Description

Override Settings If you select the Override Settings check box, this overrides the values set on the 
partner level: the AS2 Identity selected from the AS2 Identifier list is used to override 
the default AS2 identity for the host configured using the procedure described in the 
following sections:

• TIBCO BusinessConnect Trading Partner Administration Guide, Set the Host’s 
AS2 Identifier for a Protocol.

• TIBCO BusinessConnect Trading Partner Administration Guide, Disabling 
Session Cache for HTTPS.

If you clear the Override Settings check box, the default AS2 identity for the partner 
remains valid.
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3. Click Save.

AS2 Identifier Select an AS2 identity that is used to override the default AS2 identity.

Allow override of 
filename via HTTP 
parameter
(applies only to 
HTTP/S transports)

If this check box is selected, and a file reference is being passed from the private 
process, then the name of the file is passed on to the Responder in an HTTP header 
called filename.

Each partner has this check box. If it is selected and there is a fileName field in the 
HTTP message header or in QueryString (in that order), the message is written to a 
fileName file. This file is created in the shared directory located under the partner’s 
name directory. The file size is irrelevant in this case.

Note   This feature is fully supported for the Notify and Asynchronous Request 
Response operations. For the Synchronous Request Response operations, only request 
can send the filename to the partner while the partner cannot send the filename on the 
response: a synchronous response cannot be written to the file that the partner wants.

Table 27   Edit Protocol Binding: Advanced Settings for Partner (Cont’d)

Field Description
 TIBCO BusinessConnect Services Plug-in User’s Guide



68 | Chapter 8  Private Messages
Chapter 8 Private Messages

This chapter describes how to configure the private messages for the Services Plug-in.

Topics

• Overview, page 69

• Initiator Messages, page 70

• Responder Messages, page 76

• General Messages, page 82

• Multiple Attachments, page 83
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Overview

The exchange of business documents is known as the process flow. In any TIBCO 
BusinessConnect process flow, two types of messages are exchanged:

• Private messages

• Public messages   See Managing Services Plug-in Operations, page 31.

About Private Messages
Private messages are exchanged between a private process and the local TIBCO 
BusinessConnect installation. Private messages can contain a request, response, or 
notification document. The private process handles conversion from internal to public data 
and back.

• On the Initiator side, the private process converts internal data to a notification 
document.

• On the Responder side, the private process receives a request and converts it to 
internal company format.

You can generate private messages from TIBCO ActiveMatrix BusinessWorks private 
processes that use the TIBCO BusinessConnect Palette. 

The TIBCO BusinessConnect server has two major roles: 

• Initiator   This role receives request messages from private processes and transmits 
the Services Plug-in documents to your trading partners.

• Responder    This role receives Services Plug-in documents from trading partners 
and submits the converted request messages to their private processes.

The following sections describe the messages used for private request and response 
document exchange in the Services Plug-in. The message fields are packaged in the ^data^ 
control tag as part of the aeRvMsg format.

See TIBCO BusinessConnect Trading Partner Administration Guide, Chapter 7, Private 
Process Configuration for more information.
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Initiator Messages

Initiator Outbound Request — Private Process to TIBCO BusinessConnect

The Initiator private process uses this message to handle outbound requests. Data that is 
sent is in a string or in binary form. 

Subject Name prefix.installation.EZComm.INITIATOR.REQUEST

External example: AX.BC.BC-ACME.EZComm.INITIATOR.REQUEST

If both plainRequest and inputFile are passed, the plainRequest node is used.

If both binaryRequest and inputFile are passed, the binaryRequest node is used.

Table 28   Private Message: InitiatorRequest 

Field Type Required Description

fromTp String No Name of the trading partner initiating the transaction.

toTp String Yes Name of the trading partner receiving the transaction.

transactionID String Yes An ID unique within Initiator private processes 
environment for this transaction. The private process 
creates this ID.

closure String No The private process generates the closure message and 
sends it to TIBCO BusinessConnect, which is required to 
return this closure contents back in the InitiatorResponse to 
ensure that the private process can match it with the original 
Initiator.Request.

binaryRequest base64
Binary

No Private processes use the binaryRequest field to send binary 
data to TIBCO BusinessConnect.

as2-subject String No A short string identifying the topic of the AS2 message.

The value in the as2-subject element overrides the value in the 
MIME Subject field.

content-type String No Content type of the passed data.

content-disposition String No Maps to MIME's content-disposition. This value, if 
provided, is set in the MIME Internet headers.
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inputFile String No If a file reference is being passed to TIBCO 
BusinessConnect, this field is used.

httpAttributes 

name String No Name of the httpAttribute.

Note : It works only with Request_Response operations.

value String No Value assigned to the httpAttribute.

Note : It works only with Request_Response operations.

Attachment

name String No Name of the attachment file. 

For more information, see Multiple Attachments, page 83.

content Base64
Binary

No Content for the attachment.

fileName String No A file reference can be sent as an attachment. 

For more information, see Multiple Attachments, page 83.

deleteFile Boolea
n

No If set to true, the file reference specified in the filename field 
is deleted after the completion (successful or otherwise) of 
the transaction processing.

content-id String No Represents the content Id for the attachment. It must be 
specified and enforcement is performed at the 
BusinessWorks palette level. 

If this field is not specified, it is populated as 
transactionID-sequence number.

content-type String No Represents the content type of the message content.

For more information, see Multiple Attachments, page 83.

Table 28   Private Message: InitiatorRequest (Cont’d)

Field Type Required Description
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Initiator Inbound Response — BusinessConnect to Private Process

The Initiator private process uses this message to handle inbound responses.

Subject Name prefix.installation.EZComm.INITIATOR.RESPONSE

External example: AX.BC.ACME.EZComm.INITIATOR.RESPONSE

Table 29   Private Message: Initiator Response (Sheet 1 of 4)

Field Type Required Description

resend Boolean No A boolean value indicating whether a message is resent.

standardID String Yes Protocol name.

fromTp String No Name of the trading partner initiating the transaction.

toTp String Yes Name of the trading partner receiving the transaction.

operationID String No A three-part ID of the form: 
category/version_number/operation_Name.

transactionID String No An ID unique within Initiator private processes 
environment for this transaction. The private process 
creates this ID.

statusCode String No Code indicating the status of the message. 200 for 
success. Otherwise, a code that represents the type of 
error. 

statusMsg String No OK or a description of the cause of the error.

closure String No The private process generates the closure message and 
sends it to TIBCO BusinessConnect. TIBCO 
BusinessConnect is required to return this closure 
contents back in the InitiatorResponse to ensure that the 
private process can match it with the original 
InitiatorRequest.

duplicate Boolean No Specifies whether the incoming response is a duplicate.

binaryResponse String No Response is sent to this field if it contains binary data.

responseFile String No File name containing the response.
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originalFileName String No This field contains the filename of the original response 
file in an Asynchronous request response operation:

• If a response is received over the FILE or FTP 
transport, this is the actual filename that is in the 
directory or on the FTP server. 

• For HTTP/s transports, this is the filename that is 
sent as a file reference from the private process 
when the Allow override of filename via HTTP 
parameter check box for the partner is selected.

See Allow override of filename via HTTP 
parameter (applies only to HTTP/S transports).

as2-subject String No A short string identifying the topic of the AS2 message.

as2-to String No A short string aiding the receiving system in identifying 
the sending system.

The as2-to and as2-from headers are used.

as2-from String No A short string aiding the receiving system in identifying 
the sending system.

The as2-to and as2-from headers are used.

email-subject String No A string receiving an email subject by the EMAIL or 
AS1-EMAIL transport.

Attachment

name String No Name of the attachment file. 

For more information, see Multiple Attachments, 
page 83.

content any No Content for the attachment.

fileName String No A file reference can be sent as an attachment. 

For more information, see Multiple Attachments, 
page 83.

deleteFile Boolean No If set to true, then the private process can decide to 
delete the inbound attachment file.

Table 29   Private Message: Initiator Response (Sheet 2 of 4)

Field Type Required Description
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content-id String No Represents the content Id for the attachment. It must be 
specified and enforcement is performed at the 
BusinessWorks palette level. If this field is not 
specified, it is populated as transactionID-sequence 
number.

content-type String No Represents the content type of the message content.

For more information, see Multiple Attachments, 
page 83.

Table 29   Private Message: Initiator Response (Sheet 3 of 4)

Field Type Required Description
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Body

stringData

(plainResponse)

String No Response is sent to this field if it contains string data.

Table 29   Private Message: Initiator Response (Sheet 4 of 4)

Field Type Required Description
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Responder Messages

Responder Inbound Request — BusinessConnect to Private Process

The Responder private process uses this message to handle inbound requests.

Subject Name prefix.installation.EZComm.RESPONDER.REQUEST 

External example: AX.BC.BC-ACME.EZComm.RESPONDER.REQUEST

Table 30   Private Message: ResponderRequest (Sheet 1 of 3)

Field Type Required Description

resend Boolean No A boolean value indicating whether a message is resent.

standardID String Yes Protocol name.

fromTp String Yes Name of the trading partner who initiated the transaction.

toTP String Yes Name of the trading partner who received the transaction.

operationID String No A three-part ID of the form: 
category/version_number/operation_Name.

transactionID String Yes A unique ID generated by TIBCO BusinessConnect when 
publishing the transaction to the private process's 
environment.

closure String No A closure message generated by the private process and 
sent to TIBCO BusinessConnect. 

binaryRequest base64Bin
ary

No Used by TIBCO BusinessConnect to send data when 
binary data is being passed to a partner.

isBinaryFile Boolean No This field shows whether the file specified in the field 
inputFile is a binary file.

inputFile String No Used for a file reference that was passed to TIBCO 
BusinessConnect.

operationType String No Represents the type of the operation, such as Notify, 
Synchronous Request Response, or Asynchronous 
Request Response.

duplicate Boolean No Specifies whether the incoming request is a duplicate.
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originalFileName String No This field contains the filename of the original request 
file: 

• For the FILE and FTP transports, this is the actual 
filename that is in the directory or on the FTP server, 

• For HTTP/s transports, this is the filename that is sent 
as a file reference from the private process when the 
Allow override of filename via HTTP parameter 
check box for the partner is selected.

See Allow override of filename via HTTP parameter 
(applies only to HTTP/S transports)

as2-subject String No A short string identifying the topic of the AS2 message.

as2-to String No A short string aiding the receiving system in identifying 
the sending system.

The as2-to and as2-from headers are used.

as2-from String No A short string aiding the receiving system in identifying 
the sending system.

The as2-to and as2-from headers are used.

email-subject String No A string receiving an email subject by the EMAIL or 
AS1-EMAIL transport.

Attachment

name String No Name of the attachment file. 

For more information, see Multiple Attachments, page 83.

content any No Content for the attachment.

fileName String No A file reference can be sent as an attachment. 

For more information, see Multiple Attachments, page 83.

deleteFile Boolean No If sets to true, then the private process can decide to delete 
the inbound attachment file.

Table 30   Private Message: ResponderRequest (Sheet 2 of 3)

Field Type Required Description
 TIBCO BusinessConnect Services Plug-in User’s Guide
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content-id String No Represents the content Id for the attachment. It must be 
specified and enforcement is performed at the 
BusinessWorks palette level. If this field is not specified, 
it is populated as transactionID-sequence number.

content-type String No Represents the content type of the message content.

For more information, see Multiple Attachments, page 83.

Table 30   Private Message: ResponderRequest (Sheet 3 of 3)

Field Type Required Description
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Responder Outbound Response — Private Process to BusinessConnect

The Responder private process uses this message to handle outbound responses.
.

Subject Name prefix.installation.EZComm.RESPONDER.RESPONSE 

External example: AX.BC.BC-ACME.EZComm.RESPONDER.RESPONSE

Table 31   Private Message: Responder.Response 

Field Type Required Description

statusCode Integer Yes Code indicating the status of the message (200 for 
success). Otherwise, a code that represents the type of 
error. 

statusMsg String Yes OK or a description of the cause of the error.

binaryResponse Base64B
inary

No Response is sent to this field if it contains binary data.

responseFile String No This is the name of the file that contains the response.

deleteResponseFile Boolean Deletes the response file if the value is true.

closure String Yes This is the closure that is received from the Responder 
Request Based on this value, this response is correlated to 
the request.

content-type String No Content type of the response. If not specified, TIBCO 
BusinessConnect interprets this value.

content-disposition String No Maps to MIME's content-disposition. This value, if 
provided, is set in the MIME Internet headers.

as2-subject String No A short string identifying the topic of the AS2 message.

By default, the value in the as2-subject element is the same 
with the one in the MIME Subject field.

Attachment

name String No Name of the attachment file. 

For more information, see Multiple Attachments, 
page 83.

content Any No Content for the attachment.
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fileName String No A file reference can be sent as an attachment. 

For more information, see Multiple Attachments, 
page 83.

deleteFile Boolean No If set to true, the file reference specified in the filename 
field is deleted after the completion (successful or 
otherwise) of the transaction processing.

content-id String No Represents the content Id for the attachment. It must be 
specified and enforcement is performed at the 
BusinessWorks palette level. If this field is not specified, 
it is populated as transactionID-sequence number.

content-type String No Represents the content type of the message content.

For more information, see Multiple Attachments, 
page 83.

Body

stringData

(plainResponse)

String No Response is sent to this field if it contains string data.

Table 31   Private Message: Responder.Response (Cont’d)

Field Type Required Description
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Responder Acknowledgement — Private Process to BusinessConnect

The Responder TIBCO BusinessConnect sends this acknowledgement after it receives the 
Responder Response. The acknowledgement indicates whether the Responder Response 
has been forwarded to the trading partner.
.

Subject Name prefix.installation.EZComm.RESPONDER.ACK

External example: AX.BC.BC-ACME.EZComm.RESPONDER.ACK

Table 32   Private Message: Responder.Ack

Field Type Required Description

statusCode String Yes Code indicating the status of the message (200 for 
success). Otherwise, a code that represents the type of 
error. 

statusMsg String Yes OK or a description of the cause of the error.

operationType String No Represents the type of the operation. In this case it is 
ack, indicating that the message is of the type 
Acknowledgement.

closure String Yes A closure sent by the Responder Response message.
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General Messages

Error Messages

TIBCO BusinessConnect uses the error message to publish status information.

Subject Name prefix.installation.EZComm.ERROR

Example: AX.BC.BC-ACME.EZComm.ERROR

Table 33   Private Message: Error Message

Field Type Required Description

statusCode String No One of the private party-defined status and error codes.

statusMsg String No The string representing the cause of one of the private 
party-defined status or error codes. 

details String No Additional information.

msgDirection String No The flow of the message, either inbound or outbound.

closure String No Reserved.

operationID String No A three-part ID of the form: 
category/version_number/operation_Name.

transactionID String No A unique ID generated by TIBCO BusinessConnect when 
publishing the transaction to the private process's 
environment.

standardID String Yes Protocol name.

timestamp String No Time stamp for this message.

host String No Host name.

tpName String No Trading partner name.

extraInfo String No This field contains the originalFileName when available.

Body

stringData String No
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Multiple Attachments

The Services Plug-in allows you to send attachments to the trading partner. The current 
private process schema accommodates attachments so that the attachment field represents 
a sequence which allows any number of attachments to be specified.

The fields available for configuring an attachment are as follows:

• name   This represents the name of the attachment. If none is specified, it is named 
AttachmentsequenceNumber.second part of the content type.      

For example, if you are sending an .xml file, the content type is text/xml and the 
attachment name is Attachment0.xml. (1 is the sequence number for the first element of the 
attachment sequence).

• content   Content of the attachment.

• fileName   A file reference can be sent as an attachment. The content of this file is 
read and set to the content of the attachment. 

— If both the content and fileName fields are specified, then content is set as the attachment 
data. 

— If neither the content nor the fileName fields are specified, then this attachment element 
is not processed. 

Specifying of these fields is not enforced by the private process. 

• deleteFile   This is a Boolean field. If set to true, the file reference specified in the 
filename field is deleted after the completion (successful or otherwise) of the 
transaction processing.

• contentID   Represents the content Id for the attachment. It must be specified and 
enforcement is performed at the BusinessWorks palette level. If this field is not 
specified, it is populated as transactionID-sequence number.

• contentType    Represents the content type of the message content. If not specified, it 
is inferred by the protocol. If this field is set to text/foo, the content field must hold a 
java.lang.String object. If this field is not set and the content field holds a 
java.lang.String object, the contentType field defaults to text/plain. If contentType is not set 
and the content field does not hold a java.lang.String object, the contentType defaults to 
application/octet-stream.

If there is no contentType field specified, such as when neither content nor the fileName fields are 
specified, the attachment is not processed.
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Resending Services Plug-in Private Process Messages 

The Services Plug-in can resend the private process messages that are in audit states 
RECEIVED_FROM_PP and SEND_TO_PP. 

The following is the relationship between the audit states and private process message 
types:

• On the Initiator side

RECEIVED_FROM_PPINITIATOR.REQUEST

SEND_TO_PPINITIATOR.RESPONSE

• On the Responder side

RECEIVED_FROM_PPRESPONDER.RESPONSE

SEND_TO_PPRESPONDER.REQUEST

The message RESPONDER.REQUEST is not resendable for the synchronous transactions: it is 
only resendable for the Notify and asynchronous transactions. 

The message RESPONDER.RESPONSE is not resendable for any transaction type. 

Once a message is sent in the Services Plug-in format, the resent message is also in the 
same format. 
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Chapter 9 Viewing Logs

This chapter explains the use of logs in the Services Plug-in.

Topics

• Audit Logs, page 86

• Non-Repudiation Logs, page 90

• Resending Transactions, page 93
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Audit Logs 

The audit log is used to store information about the messages and documents processed by 
TIBCO BusinessConnect Services Plug-in. 

You can use the audit log to follow the processing states of inbound or outbound 
documents. Some of the types of information stored in the audit log include: sent and 
received documents; document originator; trading partner name; processing status; and 
validation errors. 

For more information about audit logs, see TIBCO BusinessConnect Trading Partner 
Administration Guide, Audit Logs.

Configure an Audit Log for the Services Plug-in
To configure an audit log for the Services Plug-in:

1. Click BusinessConnect > Log Viewer.

2. On the Log Viewer page, click radio button next to EZComm.

3. Click the Audit tab, and configure the audit log search. 

The entire AESchema is stored in the fields REQUEST_FROM_PP and SEND_TO_PP fields in the 
audit log, since this is required for the resend.

• When doing searches, remember that the asterisk (*) is not considered to work as a 
wildcard, but represents a part of a name.

• TIBCO BusinessConnect Services Plug-in does not record advisory messages, such as 
the Responder Acknowledgement, in the audit log.
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Table 34 lists the options to select for the audit log.

Advanced Filters 4. Click Add, the Advanced Filters page is displayed.

Table 35 lists the options to select in the Advanced section of the audit log.

Table 34   Audit Log: Search Filters 

Column Name Definition

Status Select a specific status:

• ANY

• CANCELED

• COMPLETED

• ERROR

• ERROR SECURITY

• PENDING

• RECEIPT PENDING

Connection Select the database which you have connected to.

Date Range From the Date Range list, you can select the period to search:

• One Day

• One Week

• One Month

• One Year

• Custom

If Custom is selected from the Date Range list, additional editable fields for 
Start and End of the search period become available.

Table 35   Audit Log: Advanced Filters 

Column Definition

Save as Query Enter the name under which you want to save the query you define in this page.

Gateway Instance 
Information

Gateway Instance Information.

Boolean search using: is, contains, is not, is not like.
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AS2 Message ID AS2 Message ID.

Boolean search using: is, contains, is not, is not like.

Gateway Instance 
Information

Gateway Instance Information.

Boolean search using: is, contains, is not, is not like.

Host Host name.

Boolean search using: is, contains, is not, is not like.

Trading Partner Trading Partner name.

Boolean search using: is, contains, is not, is not like.

Operation ID Operation ID.

Boolean search using: is, contains, is not, is not like.

DocumentID Document ID (This is always a unique name).

Boolean search using: is, contains, is not, is not like.

Host Initiates For the Initiator, this value is true for any type of transaction (Notify , Synchronous 
Request Response, or Asynchronous Request Response). For the Responder, this value 
is always false. This value is true for outgoing requests, while for incoming requests and 
for outgoing responses this value is false.

Boolean search using: is, contains, is not, is not like.

User TranID The user transactionID column displays the transaction ID received from the private 
process on the Initiator side. 

Initiator forwards this ID to the Responder and at the same displays it in this column. 
This way, a transaction initiated by the Initiator can be cross-referenced on the 
Responder side. This feature works only for HTTP/S and Email transports. For File and 
FTP/S transports, this column is left blank.

Boolean search using: is, contains, is not, is not like.

Table 35   Audit Log: Advanced Filters (Cont’d)

Column Definition
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5. After defining the filters, click Save.

6. You can search the audit logs by grouping them according to the selected criteria.

Select any of the available criteria from the Group by list:

— None

— Date Group

— Host

— Trading Partner

— Operation ID

— Document ID

— Host Initiates

— User TranID

— Transaction Type

To learn more about these options, see TIBCO BusinessConnect Trading Partner 
Administration Guide.

Transaction Type Type of the transaction you are searching. The valid values for the field are as follows:

• EZComm-Notify (Notify operation for EZComm)

• EZComm-Async (Async operation for EZComm)

• EZComm-Sync (Sync operation for EZComm)

Boolean search using: is, contains, is not, is not like.

Table 35   Audit Log: Advanced Filters (Cont’d)

Column Definition
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Non-Repudiation Logs

The non-repudiation log is used to provide proof of the delivery of messages. 
Non-repudiation depends on authentication using digital signatures. Incoming messages 
which have been digitally signed are authenticated and stored in the non-repudiation 
database. Outbound messages that have been digitally signed are also stored in the 
database.

For more information about non-repudiation logs, see TIBCO BusinessConnect Concepts, 
Non-Repudiation.

Configure a Non-Repudiation Log for the Services Plug-in
To configure a non-repudiation log for the Services Plug-in:

1. Click BusinessConnect > Log Viewer.

2. On the Log Viewer page, click radio button next to EZComm.

3. Click Non-Repudiation.

Filters 4. Configure transactions to search. 

Table 36 lists the options to select in the Filters section of the non-repudiation log.

Table 36   Non-Repudiation Logs: Search Filters 

Column Name Definition

Status Select a specific status:

• ANY 

• CANCELED

• COMPLETED

• ERROR

• ERROR SECURITY

• PENDING

• RECEIPT PENDING

Connection Select the database which you connect to.
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Advanced Filters 5. Click Add to configure the advanced search filters.

Table 37 lists the options to select in the Advanced section of the non-repudiation log.

6. After defining the filters, click Save.

Date Range Select the period to search from the Date Range list:

• One Day

• One Week

• One Month

• One Year

• Custom

If Custom is selected from the Date Range list, additional editable fields for Start 
and End of the search period become available.

Table 36   Non-Repudiation Logs: Search Filters (Cont’d)

Column Name Definition

Table 37   Non-Repudiation Logs: Advanced Filters

Column Definition

Save as Query Enter the name under which you want to save the query you define in this dialog.

Trading Partner Name of the Trading Partner.

Boolean search using: is, contains, is not, is not like.

Operation ID Operation ID.

Boolean search using: is, contains, is not, is not like.

Document ID Document ID.

Boolean search using: is, contains, is not, is not like.

User TranID The user transactionID column displays the transaction ID received from the private 
process on the Initiator side. 

Boolean search using: is, contains, is not, is not like.

Transaction Type Type of the transaction you are searching.

Boolean search using: is, contains, is not, is not like
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7. You can search the non-repudiation logs by grouping them according to the selected 
criteria.

Select any of the available criteria from the Group by list:

— None

— Host

— Date Group

— Trading Partner

— Operation ID

— Document ID

— User TranID

— Transaction Type

To learn more about these options, see TIBCO BusinessConnect Trading Partner 
Administration Guide.
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Resending Transactions

The resend log provides two views into the audit log:

• Resendable Transactions  Search for resendable and resend transactions. 

• Resend History  View transactions that have been resent.

For more information about resend logs, see TIBCO BusinessConnect Trading Partner 
Administration Guide.

Resendable Transactions
To configure a resendable transaction for the Services Plug-in:

1. Click BusinessConnect > Log Viewer.

2. On the Log Viewer page, click radio button next to EZComm.

3. Click Resendable Transactions. 

Filters 4. Configure transactions to search. 

Table 36 lists the options to select in the Filters section of the non-repudiation log.

For the state RECEIVED_FROM_PP, the Outbound File Poller messages cannot appear in the 
list of resendable transactions and therefore cannot be resent.

For the state SEND_TO_PP, the Outbound File Poller messages can appear in the list of 
resendable transactions.

The resendable transactions that are shown on the screen depend on the Private Processes 
that are configured.

If TIBCO Rendezvous (or JMS) is configured for Private Process communication, only 
the messages sent over or received from Rendezvous (or JMS) transport is displayed.
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Table 38 lists the options to select in the Filters section for Resendable Transactions.

Advanced Filters 5. Click Add to configure the advanced search filters.

Table 39 lists the options to select in the Advanced section of the non-repudiation log.

Table 38   Resendable Transactions: Search Filters

Column Name Definition

Status Select a specific status:

• ANY 

• CANCELED

• COMPLETED

• ERROR

• ERROR SECURITY

• PENDING

• RECEIPT PENDING

Connection Select the database which you connect to.

Date Range Select the period to search from the Date Range list:

• One Day

• One Week

• One Month

• One Year

• Custom

If Custom is selected from the Date Range list, additional editable fields for Start 
and End of the search period become available.

Table 39   Resendable Transactions: Advanced Filters 

Column Definition

Trading Partner Boolean search using: is, contains, is not, is not like.

Operation ID Operation ID.

Boolean search using: is, contains, is not, is not like.

Document ID Boolean search using: is, contains, is not, is not like.
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6. After defining the filters, click Save.

7. You can search the non-repudiation logs by grouping them according to the selected 
criteria.

Select any of the available criteria from the Group by list:

— None

— Date Group

— Host

— Trading Partner

— Operation ID

— Document ID

— Host Initiates

— User TranID

— Transaction Type

User TranID Boolean search using: is, contains, is not, is not like.

The user transactionID column displays the transaction ID received from the private 
process on the Initiator side. 

Initiator forwards this ID to the Responder and at the same displays it in this column. 
This way, a transaction initiated by the Initiator can be cross-referenced on the 
Responder side. This feature works only for HTTP/S and Email transports. 

For File and FTP/S transports, this column is left blank.

Transaction Type Boolean search using: is, contains, is not, is not like.

Type of the transaction you are searching.

Host Initiates Boolean search using: is, contains, is not, is not like.

• For the Initiator, this field is true for any type of transaction (Notify, Synchronous 
Request Response, or Asynchronous Request Response). 

• For the Responder, it is always false.

This value is true for outgoing requests, while for incoming requests and for outgoing 
responses this value is false.

Table 39   Resendable Transactions: Advanced Filters (Cont’d)

Column Definition
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To learn more about these options, see TIBCO BusinessConnect Trading Partner 
Administration Guide.

Resend History 
To view the resend history for the Services Plug-in:

1. Click BusinessConnect > Log Viewer.

2. On the Log Viewer page, select radio button next to EZComm.

3. Click Resend History. 

Table 40 lists the options to select in the Filters section of the Resend history log.

Advanced Filters 4. Click Add to configure the advanced search filters.

Table 40   Resend History: Search Filters 

Column Name Definition

Status Select a specific status:

• ANY 

• CANCELED

• COMPLETED

• ERROR

• ERROR SECURITY

• PENDING

• RECEIPT PENDING

Connection Select the database which you connect to.

Date Range From the Date Range list, you can select the period to search:

• One Day

• One Week

• One Month

• One Year

• Custom

If Custom is selected from the Date Range list, additional editable fields for Start 
and End of the search period become available.
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Table 41 lists the options to select in the Advanced section of the non-repudiation log.

5. Click Save.

6. You can search the non-repudiation logs by grouping them according to the selected 
criteria.

Table 41   Resend History: Advanced Filters 

Column Definition

Host Host name.

Boolean search using: is, contains, is not, is not like.

Trading Partner Boolean search using: is, contains, is not, is not like.

Operation ID Boolean search using: is, contains, is not, is not like.

Document ID Boolean search using: is, contains, is not, is not like.

Host Initiates Boolean search using: is, contains, is not, is not like.

• For the Initiator, this field is set to true for any type of transaction (Notify , 
Synchronous Request Response, or Asynchronous Request Response). 

• For the Responder, it is always false.

This value is true for outgoing requests, while for incoming requests and for outgoing 
responses this value is false.

User TranID Boolean search using: is, contains, is not, is not like.

The User TranID column displays the transaction ID received from the private process 
on the Initiator side. 

The initiator forwards this ID to the Responder and at the same displays it in this 
column. This way, a transaction initiated by the Initiator can be cross-referenced on the 
Responder side. This feature works only for HTTP/S and Email transports. 

For File and FTP/S transports, this column is left blank.

Transaction Type Boolean search using: is, contains, is not, is not like.

Type of the transaction you are searching.
 TIBCO BusinessConnect Services Plug-in User’s Guide



98 | Chapter 9  Viewing Logs
Select any of the available criteria from the Group by list:

— None

— Date Group

— Host

— Trading Partner

— Operation ID

— Document ID

— Host Initiates

— User TranID

— Transaction Type

To learn more about these options, see TIBCO BusinessConnect Trading Partner 
Administration Guide.
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Chapter 10 File Pollers 

This chapter explains outbound and inbound File pollers for the Services Plug-in.

Topics

• Outbound File Pollers for the Services Plug-in, page 100

• Inbound File Pollers for the Services Plug-in, page 101
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Outbound File Pollers for the Services Plug-in

The outbound File poller provides a simple way for private processes to transmit 
documents to TIBCO BusinessConnect. This contrasts with the other transports, which are 
used for communication between trading partners. 

Outbound File pollers are used by enterprises that do not want to use TIBCO Rendezvous 
to transfer documents to TIBCO BusinessConnect.

URI Format for Outbound File Pollers

For the File transport, URI format is as follows: file://BaseDir/*.*

This causes all directories under BaseDir to be checked for files. 

In order for the file to be handled by the Services Plug-in, the document must appear as 
follows:

• Default behavior, such as for the operation BC/1.0/Notify:

BaseDir/TpName

• Non-default behavior, for other operations:

BaseDir/TpName/Category_Version_OperationID

where 

• BaseDir is a user selected base directory

• TpName is the name of the trading partner 

• Category is the operation category

• Version is the operation version

• OperationID is the operation ID

If Category_Version_OperationID is not provided, then it defaults to BC/1.0/Notify.

Since the default operation has changed from BC/Notify to BC/1.0/Notify, files in the 
Category_operationID directory are treated as Category_Empty_operationID; for example, TIBCO 
BusinessConnect looks for an operation Category/Empty/operationID in the configuration 
store. To read general information on how to enable an outbound File poller, see TIBCO 
BusinessConnect Trading Partner Administration Guide, Outbound File Pollers.

The sending partner for outbound File pollers is assumed to be the default host.
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Inbound File Pollers for the Services Plug-in

When File outbound is used as a transport, the trading partner uses an inbound File poller 
to check for the documents. 

To read general information on how to enable an inbound File poller, see TIBCO 
BusinessConnect Trading Partner Administration Guide, Inbound File Pollers.

For the inbound File pollers, the receiving partner is assumed to be the default host.
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Appendix A Troubleshooting

This appendix offers troubleshooting advice for the Services Plug-in.

Topics

• Troubleshooting the Services Plug-in, page 103
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Troubleshooting the Services Plug-in

ORIG_FILE_NAME and ORIG_FILE_PATH are not populated when using outbound File poller to 
send files from private processes

When using outbound File poller to send files from private processes, the file slots 
ORIG_FILE_NAME and ORIG_FILE_PATH may not be populated. The ORIG_FILE_NAME and 
ORIG_FILE_PATH properties are populated by the protocol to indicate the original source of 
data, if any. When you use outbound File poller in EZComm, these properties are not set 
but the location of the source file is set on the OUTPUT_SOURCE_DIR and SRC_FILE_NAME 
properties instead.

Outbound transactions for HTTP are not entered in the non-repudiation log

Non-repudiation logs, in general, are used for signed messages to avoid disputes between 
trading partners. When using HTTP with the the Services Plug-in, there are two types of 
signed messages that can be exchanged:

• Inbound signed messages   These messages are posted to the non-repudiation log. 
Since the trading partner already signed such message and the signature can be 
verified, there can be no dispute that the message came from this specific trading 
partner.

• Outbound signed messages  When a signed message is sent using HTTP outbound, 
there is no ability to request a receipt. The trading partner’s HTTP server can officially 
acknowledge that the message was received, but it cannot verify the signature on the 
message. The acknowledgement from the HTTP server about the message arrival is 
not the same as the acknowledgement from the trading partner who actually received 
and processed the message.

Therefore, if TIBCO BusinessConnect would post such outbound signed message into 
the non-repudiation log, the other trading partner could still dispute that they received 
the message. For that reason, HTTP transport in the the Services Plug-in does not 
enter outbound signed messages in the non-repudiation log.

When I import the whole configuration, the operation is not imported

When an operation in a .csx file already exists in the BusinessConnect system, upon 
importing the .csx file this operation is not imported. 

For example, if you try to import the operation BC/version/operation, which exists by 
default, you need to rename the existing BC/version/operation (such as BC/6.0/operation1) in 
order to import a new operation with the same name. The exception is the default 
operation BC/1.0/Notify, which cannot be renamed or deleted: this operation has to be 
updated manually.
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Appendix B FTP Script Examples

This appendix contains some sample scripts for the Services Plug-in.

Topics

• Overview, page 106

• First Tutorial Example, page 107

• Second Tutorial Example, page 111

• Third Tutorial Example, page 113

• Fourth Tutorial Example, page 118

• Fifth Tutorial Example, page 119

To use scripts you must install the FESI EcmaScript Interpreter as described in TIBCO 
BusinessConnect Installation and Configuration, Installing FESI EcmaScript Interpreter 
to Support Custom Scripts.
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Overview

The following script examples are included with TIBCO BusinessConnect:

• First Tutorial Example shows simple FTP file transfers using the FTP API provided 
with TIBCO BusinessConnect.

• Second Tutorial Example shows how to call Java methods from inside the FTP scripts 
and how to execute a batch/shell program before sending the file to the FTP server.

• Third Tutorial Example shows how to connect the SSHFTPClient object to the 
SSHFTP server.

• Fourth Tutorial Example shows simple FTP file transfers messages using the PGP API 
provided with TIBCO BusinessConnect.

• Fifth Tutorial Example shows messages from or to SSHFTP server are processed 
using the PGP API provided with TIBCO BusinessConnect.
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First Tutorial Example

The putexample.txt script puts the document on the FTP server. The mgetexample.txt script does 
an mget from the FTP server of all files that match a particular search filter, which in this 
example is the trading host name.

How putexample.txt Works

This script gets the FTPClient object from the job variable that is created at runtime by 
BusinessConnect. The FTPClient object is used to connect to the FTP server. (This works 
only in non-proxy mode.) It checks if the examples/BC directory is available. If it is, it puts 
the file created by the Initiator's outbound process. If the examples/BC directory is not 
present, that directory is created before the file is actually stored in the FTP server. 

If there are connection failures, a flag called retryScripts is set to true and passed on to TIBCO 
BusinessConnect to retry the execution when retry of the outbound process occurs. 

How mgetexample.txt Works

This script gets the FTPClient object from the job variable that is created at runtime by 
TIBCO BusinessConnect. FTPClient object is used to connect to the FTP server. It checks if 
the examples/BC directory is available. If it is, the script calls executeMgetCmd to get all the files 
from the FTP Server. 

Once the files are successfully retrieved, the examples/BC directory is deleted. If the files 
could not be retrieved for some reason, for example, if a put is happening at the same time 
and the file descriptor is being locked by another process, then the examples/BC directory is 
not removed. 

Tutorial Files

The following files are part of this tutorial:

• BC_HOME\samples\bc\ftpscripts\putexample.txt

• BC_HOME\samples\bc\ftpscripts\mgetexample.txt

These are both EcmaScript files.

How to Send Files

To send a document using BusinessWorks process, see File Pollers. 
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Setting Up the First Tutorial

Steps to Perform on the Initiator Computer

The following steps must be performed on the Initiator computer:

1. Configure trading partners and a business agreement as described in Importing the 
Tutorial, page 8.

2. For the participant Seller, click the Transports tab for the EZComm protocol.

3. Click Add.

4. Enter a name for the transport in the Name field.

5. Select FTP in the Type list.

6. Click OK.

7. Enter other information as needed. 

See TIBCO BusinessConnect Trading Partner Administration Guide, FTP/S 
Outbound for details.

8. Select Script in the File Processing list.

9. Click change in the Scripts area. 

10. Select Uploaded File from the Type list.

11. Click Browse to navigate to the BC_HOME\samples\bc\ftpscripts directory. 

12. Select the putexample.txt file and then click Open.

13. Click OK.

14. Click Save.

15. Click TIBCO BusinessConnect > BusinessAgreements > Buyer-Seller.

16. Click EZComm in the Agreement Protocol Binding list.

17. Click the Transports tab.

18. Select FTP from the Primary Transport list.

19. Click Save twice.

Steps to Perform on the Responder Computer

The following steps must be performed on the Responder computer:

1. Configure trading partners and a business agreement as described in Configuring the 
Responder TIBCO BusinessConnect.

2. Click TIBCO BusinessConnect > BusinessAgreements > Buyer-Seller.
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3. Click the EZComm protocol binding.

4. Click the Transports tab.

5. Click Edit FTP Settings in the Inbound Transports for Partner ’Buyer’ area.

6. Configure FTP. If you need help, see TIBCO BusinessConnect Trading Partner 
Administration Guide, Select and Configure FTP/S Inbound.

7. Select Script in the File Processing list. 

8. Click change in the Scripts field.

9. Select Uploaded File from the Type list.

10. Click Browse to navigate to the BC_HOME\samples\bc\ftpscripts directory.

11. Select the mgetexample.txt file. Click Open.

12. Click OK.

13. Select the Delete File check box.

14. Click Save twice.

Running the First Tutorial Example
To run the first tutorial example:

1. Start TIBCO BusinessConnect on the Initiator and Responder computers. 

2. Send a document by using the outbound File poller. 

To configure TIBCO BusinessConnect to poll a directory:

a. Create a directory in which you put the document that is transmitted using the FTP 
script. This directory needs to be named according to the conventions explained in 
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TIBCO BusinessConnect Trading Partner Administration Guide, field Directory 
to Monitor.

b. Specify Seller for the TpName directory. If your base directory is BaseDir, the 
directory path should be BaseDir/Seller.

c. In TIBCO Administrator, click Application Management > BusinessConnect > 
Configuration.

d. Click the BusinessConnect link.

e. Click the Private Process Configuration tab.

f. Click the EZComm link in the Outbound File Poller Configuration section.

g. Select the Enable check box.

h. Type BaseDir/Seller/*.* in the Directory to Monitor field.

i. Click Save twice.

j. Click Deploy.

k. Click OK.

l. Restart the BusinessConnect server if it was not started when you clicked Deploy.

3. Copy the BC_HOME\protocols\ezcomm\samples\sampleXML\ WidgetAvailable.xml file into 
BaseDir/Seller.

Expected Results
After the Initiator BusinessConnect receives the file from the TIBCO ActiveMatrix 
BusinessWorks process or picks up the file from the outbound file poller directory, the 
following situations happen:

• BusinessConnect establishes contact with the FTP server, passing the user name and 
password specified in the FTP transport configuration for Seller. 

• BusinessConnect then invokes the putexample.txt script. The script looks for the directory 
examples/BC in the FTP root directory and creates them if they do not exist. 

• Finally, the file is written to examples/BC.

On the Responder, BusinessConnect polls the directory specified in the inbound FTP 
configuration in the business agreement. When a file is detected, BusinessConnect runs 
the mgetexample.txt script, which looks for all the files in the examples/BC directory.
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Second Tutorial Example

The modifyexample.txt script shows how to call Java methods from inside the FTP scripts and 
how to execute a batch/shell program before sending the file to the FTP server. The 
batch/shell program calls a Java program that modifies the document by adding CRLF 
(\r\n) at the end of the document. The executePutCmd method is then executed to store the file 
at the FTP server. 

This example is a demonstration that Java classes can be called from scripts at runtime and 
external programs can be called by using the Java runtime class. 

How modifyexample.txt Works

This script is the same as putexample.txt except for one minor change. Before connecting to 
the FTP server, the source file name, which is a reference to the file that is stored locally 
before the script execution takes place, is sent to the executeProgram method in the RunProgram 
class. This method sends the fileName reference to a batch/shell program 
BC_HOME\samples\bc\ftpscripts\bcfilemodifier.bat. The batch file/shell program calls the Java class 
ModifyFile, which adds a CRLF at the end of the document file that is being transferred to 
the FTP server. Once the file is modified it is stored on the FTP server that is available to 
the trading partner.

If you want to perform a full round trip of your transaction, you can upload mgetexample.txt 
from the first example to retrieve the files from the FTP server so that the Responder 
trading partner can process the document that was uploaded after the modification. 

Tutorial Files

The following files are part of this tutorial: 

• BC_HOME\samples\bc\ftpscripts\modifyexample.txt

• BC_HOME\samples\bc\ftpscripts\ftpexample.jar

Setting Up the Second Tutorial
The following steps are necessary to set up this tutorial:

1. Configure the participants and business agreement on the Initiator following the 
procedure described in Setting Up the First Tutorial. 

Note, however, that in Step 11 when selecting the uploaded script file for the file 
processing, you must select the BC_HOME\samples\bc\ftpscripts\modifyexample.txt file.

2. Stop the BusinessConnect server.

3. Copy ftpexample.jar to BC_HOME/hotfix/lib.
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4. Add these two properties in the .tra file in the directory 
TIBCO_HOME/tra/domain/domain/application/BusinessConnect directory. There is a .tra file for 
every BusinessConnect engine.

—   java.property.bc.user.execProgramName=bcfilemodifier

—   java.property.bc.user.execProgramDir= %BC_HOME%\samples\bc\ftpscripts

Running the Second Tutorial Example
To run modifyexample:

1. Start the BusinessConnect server.

2. Send a document using one of the mechanisms described in Running the First Tutorial 
Example.

Expected Results
You can notice that the file that is transferred to the FTP server location contains the extra 
CRLF. If you are trying to process this document on the Responder, there is extra CRLF at 
the end of the file.
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Third Tutorial Example

Two scripts are used for the third tutorial example:

• The ssh_putexample.txt script, which puts the document to the SSHFTP server.

• The ssh_mgetexample.txt script, which retrieves multiple files from the SSHFTP server. 
These files match a particular search filter, which in this example is the extension of 
the filename as well as the size of the file. 

How ssh_putexample.txt Works 

The ssh_putexample.txt script gets the SSHFTPClient object from the job variable that is created at 
runtime by BusinessConnect. 

The SSHFTPClient object is used to connect to the SSHFTP server, both in proxy or 
non-proxy mode. It checks whether the examples1 directory is available and proceeds as 
follows:

• If the examples1 directory is present, the script puts in the file created by the Initiator's 
outbound process.

• If the examples1 directory is not present, it is created before the file is actually stored on 
the SSHFTP server. 

If there are connection failures, a flag called retryScripts (with the constant name defined in 
the API com.tibco.ax.fw.runtime.transport.sshftp.SSHFTPClient.RETRY_SLOT) may be used to set the 
value as true, and passed on to BusinessConnect to retry the execution when retry of the 
outbound process occurs. 

How ssh_mgetexample.txt Works 

The ssh_mgetexample.txt script gets the SSHFTPClient object from the job variable that is created 
at runtime by BusinessConnect. 

The SSHFTPClient object is used to connect to the SSHFTP server. It checks whether the 
examples1 directory is available. If it is, the script calls executeMgetCmd to get all the files from 
the SSHFTP Server. 

Once the files are successfully retrieved, the files from the examples1 directory are deleted. 
If the files could not be retrieved for some reason (such as when a communication failure 
happens), the corresponding tracing and auditing entries are created. In such case, the 
script retrieves all files from the examples2 directory whose extension is *.bin and whose size 
is greater than or equal to 200 KB. Upon successful retrieval, the retrieved files are 
deleted. 
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Tutorial Files 

The following files are part of this tutorial: 

• BC_HOME\samples\bc\sshftpscripts\ssh_putexample.txt

• BC_HOME\samples\bc\sshftpscripts\ssh_mgetexample.txt

These are both EcmaScript files. 

How to Send Files 

For this example, send a document using BusinessWorks process as described in File 
Pollers. 

Setting Up the Third Tutorial 

Steps to Perform on the Initiator Computer 

The following steps must be performed on the Initiator computer: 

1. Configure trading partners and a business agreement as described in Configuring the 
Initiator TIBCO BusinessConnect.

2. For the participant Seller, click the Transports tab for the EZComm protocol.

3. Click Add.

4. Enter the transport name in the Name field.

5. Select SSHFTP in the Type list.

6. Click OK.

7. Enter other information as needed.

See TIBCO BusinessConnect Trading Partner Administration Guide, Configure 
SSHFTP Outbound for more information.

8. Select Script in the File Processing list.

9. Click change in the Scripts field. 

10. Select Uploaded File from the Type list.

11. Click Browse to navigate to the BC_HOME\samples\bc\sshftpscripts directory.

12. Click the ssh_putexample.txt file.

13. Click Open.

14. Click OK.

15. Click Save.
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16. Click BusinessConnect > BusinessAgreements > Buyer-Seller.

17. Click EZComm in the Agreement Protocol Binding list.

18. Click the Transports tab.

19. Select SSHFTP from the Primary Transport list in the Outbound Transports for the 
Host 'Buyer' area.

20. Click Save twice.

Steps to Perform on the Responder Computer 

The following steps must be performed on the Responder computer: 

1. Configure trading partners and a business agreement as described in Configuring the 
Responder TIBCO BusinessConnect.

2. Click BusinessConnect > BusinessAgreements > Buyer-Seller.

3. Click EZComm in the Agreement Protocol Binding list.

4. Click the Transports tab.

5. Click Edit SSHFTP Settings in the Allowed Inbound Transports for Partner 'Buyer' 
area.

6. Configure FTP. 

For more information, see the TIBCO BusinessConnect Trading Partner 
Administration Guide, Select and Configure SSHFTP Inbound.

7. Select Script in the File Processing list. 

8. Click change in the Scripts field.

9. Select Uploaded File from the Type list.

10. Click Browse to navigate to the BC_HOME\samples\bc\sshftpscripts directory.

11. Click the ssh_mgetexample.txt file.

12. Click Open.

13. Click OK.

14. Select the Delete File check box.

15. Click Save twice.
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Running the Third Tutorial Example 
To run the third tutorial example: 

1. Start BusinessConnect on the Initiator and Responder computers. 

2. Send a document using the outbound File poller. 

To configure BusinessConnect to poll a directory: 

a. Create a directory in which you put the document that is transmitted using the FTP 
script. This directory must be named according to the conventions explained in 
the TIBCO BusinessConnect Trading Partner Administration Guide, in the 
Directory to Monitor field.

b. Specify Seller for the TpName directory. If your base directory is BaseDir, the 
directory path should be BaseDir/Seller.

c. In TIBCO Administrator, click Application Management > BusinessConnect > 
Configuration.

d. Click BusinessConnect.

e. Click the Private Process Configuration tab.

f. Click EZComm in the Outbound File Poller Configuration area.

g. Select the Enable check box.

h. Type BaseDir/Seller/*.* in the Directory to Monitor field.

i. Click Save twice.

j. Click Deploy.

k. Click OK.

l. Restart the BusinessConnect server if it was not started when you clicked Deploy.

3. Copy the BC_HOME\protocols\ezcomm\samples\sampleXML\xsd\ WidgetAvailable.xml file into 
BaseDir/Seller. 
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Expected Results 
After the Initiator BusinessConnect receives the file from the BusinessWorks process, or 
picks up the file from the outbound File poller directory, the following situations happen: 

• BusinessConnect establishes contact with the SSHFTP server and authenticate with 
the selected authentication method specified in the SSHFTP transport configuration 
for Seller (either rsa/dsa public key or user name/password). 

• BusinessConnect then invokes the ssh_putexample.txt script. The script looks for the 
directory examples1 in the SSHFTP root directory, and creates it if it does not exist. 

• Finally, the file is written to the directory examples1.

On the Responder computer, BusinessConnect runs the configured script that polls the 
specified directories.

When a file is detected, BusinessConnect retrieves this file through the script 
ssh_mgetexample.txt. This script looks for files in the examples1 and examples2 directories as 
described above. 
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Fourth Tutorial Example

The putencrypted.txt script uses PGP API to process messages, and then puts them on the FTP 
server. 

The getdecrypted.txt script receives files and then processes them using the PGP API. These 
files match a particular search filter, which in this example is the trading host name.

How putencrypted.txt Works

This script gets the FTPClient object from the job variable that is created at runtime by 
BusinessConnect. The FTPClient object is used to connect to the FTP server. (This works 
only in non-proxy mode.) It checks if the BCFTP/in directory is available. If it is, it puts the 
file created by the Initiator's outbound process and processed by PGP API. If the BCFTP/in 
directory is not present, that directory is created before the file is actually stored in the 
FTP server. 

If there are connection failures, a flag called retryScripts is set to true and passed on to TIBCO 
BusinessConnect to retry the execution when retry of the outbound process occurs.

How getdecrypted.txt Works

This script gets the FTPClient object from the job variable that is created at runtime by 
TIBCO BusinessConnect. FTPClient object is used to connect to the FTP server. It checks if 
the testBC/out/BC directory is available. If it is, the script calls executeMgetCmd to get all the 
files from the FTP Server. 

Once the files are successfully retrieved and then processed by PGP API, the files from the 
testBC/out/BC directory is deleted. If the files could not be retrieved for some reason, for 
example, if a put is happening at the same time and the file descriptor is being locked by 
another process, then the files from the testBC/out/BC directory is not removed.

Tutorial Files

The following files are part of this tutorial:

• BC_HOME\samples\bc\ftp_bcpg\putencrypted.txt

• BC_HOME\samples\bc\ftp_bcpg\getdecrypted.txt

How to Send Files

To send a document using BusinessWorks process, see File Pollers.

The steps of setting up and running the fourth tutorial example are similar to First Tutorial 
Example.
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Fifth Tutorial Example

Two scripts are used for the fifth tutorial example:

• The ssh_putencrypted.txt script, which uses the PGP API to process documents and then 
puts them on the SSHFTP server.

• The ssh_getdecrypted.txt script, which receives files from the SSHFTP server and then 
processed them using the PGP API. These files match a particular search filter.

How ssh_putencrypted.txt Works 

The ssh_putencrypted.txt script gets the SSHFTPClient object from the job variable that is created 
at runtime by BusinessConnect. 

The SSHFTPClient object is used to connect to the SSHFTP server, both in proxy or 
non-proxy mode. It checks whether the examples1 directory is available and proceeds as 
follows:

• If the examples1 directory is present, the script puts in the file created by the Initiator's 
outbound process and processed using the PGP API.

• If the examples1 directory is not present, it is created before the file is actually stored on 
the SSHFTP server. 

If there are connection failures, a flag called retryScripts (with the constant name defined in 
the API com.tibco.ax.fw.runtime.transport.sshftp.SSHFTPClient.RETRY_SLOT) may be used to set the 
value as true, and passed on to BusinessConnect to retry the execution when retry of the 
outbound process occurs.

How ssh_getdecrypted.txt Works 

The ssh_getdecrypted.txt script gets the SSHFTPClient object from the job variable that is created 
at runtime by BusinessConnect. 

The SSHFTPClient object is used to connect to the SSHFTP server. It checks whether the 
examples1 directory is available. If it is, the script calls executeMgetCmd to get all the files from 
the SSHFTP Server. 

Once the files are successfully retrieved and then processed by the PGP API, the files from 
the examples1 directory are deleted. If the files could not be retrieved for some reason (such 
as when a communication failure happens), the corresponding tracing and auditing entries 
are created. In such case, the script retrieves all files from the examples2 directory whose 
extension is *.bin and whose size is greater than or equal to 200 KB. Upon successful 
retrieval, the retrieved files are deleted.
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How to Send Files 

For this example, send a document using BusinessWorks process as described in File 
Pollers.

Tutorial Files

The following files are part of this tutorial:

• BC_HOME\samples\bc\sshftp_bcpg\ssh_putencrypted.txt 

• BC_HOME\samples\bc\sshftp_bcpg\ssh_getdecrypted.txt

The steps of setting up and running the fourth tutorial example are similar to Third 
Tutorial Example.
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